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COMPATIBLE�LICENSE AGREEMENT� XE "LICENSE AGREEMENT" �

THE ENCLOSED SOFTWARE PROGRAMS ARE LICENSED BY IVEX TO CUSTOMERS FOR THEIR NON-EXCLUSIVE USE ON A COMPUTER SYSTEM PER THE TERMS SET FORTH BELOW.

DEFINITIONS: "Ivex" shall mean Ivex Design International, Inc., which is the owner of the copyright and author of this program. "Licensee" shall mean the end user of this Ivex Software. This Software Package consists of copyrighted computer software and copyrighted user guide ("User Guide") from Ivex.

LICENSE: We grant licensee a limited, non-exclusive license (i) to load a copy of the Software from the disk into the memory of a single (one) computer as necessary to use the Program, and (ii) to make one (1) backup or archival copy of the Software for the use with the same computer. The archival copy and original copy of the Software are subject to the restrictions in this Agreement and both must be destroyed if your continued possession or use of the original copy ceases or this Agreement is terminated.

RESTRICTIONS: Licensee may not sub license, rent, lease, sell, pledge or otherwise transfer or distribute the original copy or archival copy of the Program or the User Guide. You agree not to translate, modify, disassemble, decompile, reverse engineer, or create derivative works based on the Software or any portion thereof. Licensee also may not copy the User Guide. The Agreement automatically terminates without notice if any provision of this Agreement is breached by Licensee.

LIMITED WARRANTY: Ivex warrants that it has the right to license the Software to licensee.

Ivex warrants that the media on which the Software is furnished will be free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase. Ivex's entire liability and your exclusive remedy shall be the replacement of the Software if the media on which the Software is furnished proves to be defective. This warranty is void if the media defect has resulted from accident, abuse, or misapplication.

DISCLAIMER: Except as provided above, the Software is provided "AS IS" without warranty of any kind.

LIMITATION OF LIABILITY: THE ABOVE WARRANTIES ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. NEITHER Ivex, NOR ITS VENDORS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF USE, INTERRUPTION OF BUSINESS, NOR FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND WHETHER UNDER THIS AGREEMENT OR OTHERWISE.

EXPORT: This Software is subject to U.S. Commerce Department export restrictions, and is intended for use in the country into which Ivex sold it. 

TERMINATION: Ivex may terminate this license at any time if licensee is in breach of any of its terms or conditions. Upon termination, licensee will immediately destroy the Software or return all copies of the Software to Ivex along with any copies licensee has made.

APPLICABLE LAWS: This Agreement is governed by the laws of the state of Oregon in the United States of America, including patent and copyright laws. The prevailing party in any action or proceeding brought in connection with an alleged breach of this Agreement shall be awarded reasonable attorneys' fees to be paid by the other party. This Agreement will govern any upgrades, if any, to the program that you receive and contains the entire understanding between the parties and supersedes any proposal or prior agreement regarding the subject matter hereof. 
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�Chapter 1:  Introduction

This chapter introduces the Ivex documentation set and briefly describes how to install and run the programs.

Introducing the Ivex Documentation Set

The Ivex documentation set includes this Getting Started Guide, a Users Reference Manual, Online help, and a README.WRI �XE "README.WRI" \b�file. You can use any combination of the User's Manual and Online help for more information about how to use an Ivex program. The printed manuals are not included with all product versions, but may be purchased from Ivex at any time. The User's Manual, Online help and the README.WRI file are described in more detail below.

Using this guide

This guide shows you how to get started with the Ivex CAE programs.  Before you begin, you should:

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Already be familiar with basic principles of computer aided electronic design, and be familiar with electronics, schematics and components, and be familiar with electronic printed circuit board design.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Know how to create a schematic and generate a netlist.



This User's Guide includes the following chapters:

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Chapter 1: Introduction Introduces the documentation set and briefly describes how to install the program and how to reach us at Ivex.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Chapter 2: Running WinDraft briefly explains how to run WinDraft, describes the display features, menus and toolbars.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Chapter 3: Running WinBoard briefly explains how to run WinBoard, describes the display features, menus and toolbars.  This section also includes a Quick Start section for commonly used functions.



 �SYMBOL 252 \f "Wingdings" \s 10 \h�	Chapter 4: WinDraft Tutorial Shows you step by step how to draw a schematic, create a library part and a title block.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Chapter 5: Netlists Explains important information on how to get from the schematic to board layout, including netlist reports, module name assignment and more.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Chapter 6: WinBoard Tutorial Shows you step by step how to load a netlist from the schematic and takes you through the basics of routing a board.

Conventions used in this guide

The typographic conventions used to distinguish between commands, tool buttons, names of dialog boxes, chapter or section titles, file names, and definitions within text are as follows:

Bold type�Button or tool names and dialog box names are in bold type.��README.WRI�File names, and names of keys, are in uppercase Courier type.��Italic type�Titles of books, chapters, sections, and note text are in italic type. Italic type is also used to emphasize a word or phrase.��Bold italic type�Definitions within text are in bold italic type.��Type�In instructions, type means to type only the text. DO NOT press the ENTER key.��Enter�In instructions, enter means to type text and press the ENTER key.���SYMBOL 70 \f "Wingdings"��NOTE: Notes contain important tips.��Using Online help�XE "help:on-line" \b�

You can use any combination of the user's guide and Online help for information about how to use an Ivex program. If you prefer using Online help to find out how to use the program, you will be able to find most of the information that you would find in the users reference manual.

Online help works similarly to the Online help in other Windows-based applications. Refer to your Windows documentation for tips on how to use Online help.

The README.WRI file

The README.WRI �XE "README.WRI " \b�file contains any last minute changes or updates to the program.  Please read this before beginning.

Installation

Minimum requirements to run Ivex EDA Software

You need the following equipment:

�SYMBOL 252 \f "Wingdings" \s 10 \h�	A 486DX-based PC with a 3½ inch floppy drive and a hard drive with at least ten megabytes of available disk space for each program.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	If you are using Windows 3.1, this requires a minimum of eight megabytes of free system memory in your computer. If you are using Windows 95 or NT, this requires a minimum of 16 megabytes of free system memory in your computer.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Microsoft Windows version 3.1 or later

�SYMBOL 252 \f "Wingdings" \s 10 \h�	A color SVGA monitor (800 x 600) and suitable video adapter.

�SYMBOL 252 \f "Wingdings" \s 10 \h�	Win32s if you are using WinDraft with 16 bit Windows 3.1x.

First Time Installation procedure, Disk�XE "Installation procedure"�

To install from the A: drive, follow these steps:

	1.  Put disk in drive A:

	2.  Choose File | Run on the Windows Program Manager.

	3.  Type A:SETUP, and click OK

When the installation completes, the Ivex group window displays. Just double click on the icon to start the program.  For information about starting the program, see Chapter 2 or Chapter 3.

�SYMBOL 70 \f "Wingdings"��NOTE:  If the WinDraft icon says “MS DOS” or if you get an MS DOS error with WinDraft, this is an indication that you DO NOT have Microsoft Win32s properly installed with Windows 3.1x. Please get a copy from one of our download services listed on page iii (or directly from Microsoft) and install it before continuing.��Installation procedure, CD

Place the CD in the drive and run Setup.  If this is a first time installation, choose the typical installation to install all program components.  

If this is an update, you may want to select a custom install and choose which components of the program to install.  This is useful if you have custom library files, etc. that you do not want to overwrite.

Upgrade procedure� XE "Upgrade procedure" �

If you receive an upgrade, it contains a complete installation that will replace all existing files from the previous version.  Although we advise that you replace all existing files, you may want to backup certain files or libraries.  The old libraries are forward compatible to the new version, however the new libraries are not necessarily backward compatible.  It may be necessary to re-compile old libraries, check the readme file for instructions or contact Ivex if questions.

If you have any custom or altered libraries from the old version we advise that you make a backup copy.

You may also want to backup any other files that you have created or edited as a precaution.

After you have made backups, proceed with regular installation.

Registration� XE "Registration" �

Each Ivex product includes a bar-code and registration number.  This is usually located on your Product Registration Card and on the Manual.  If you purchased a disk only product packaged in a plastic clam shell, this number is on the back side of disk number one of the product disk set.  If you have a CD, this number is on the Jewel Case insert.

Registration Card

Please complete and return your product registration card immediately to ensure that we have your complete address and other information.  This information is used to notify you of product upgrades and other important notices.

Registration Password� XE "Password" �

The registration number also serves as a password so that you may use the program.  The program may not function properly, or only in a limited capacity until your personal registration number is properly entered.  To enter your personal registration number into the software, follow these steps:

Locate the registration number in your manual, on the product registration card, disk one or CD jewel case.

� �Double click on the icon to load the software ( it must be a new load, you can not enter the number while working on a design).

Select Help from the menu, then select Registration.

The Registration dialog box will display, see figure below.

��

�	�

     The Registration dialog box��Enter your name, company, and the complete registration password in the space provided.  THE NUMBER MUST BE ENTERED EXACTLY AND IT IS CASE SENSITIVE.  The symbol “0” is always a zero.  Type over the existing password. 

If you do not have a company name, type in “x” or enter a space, there must be something entered in each field.

Press OK when complete.

Create a new sheet or board by selecting File | New, then close the program to record the new password.  Your password is now saved.



This process is only necessary once after the program is installed.  If re-installation is required, then it will be necessary to re-enter the registration password.

How to reach us at Ivex

Ivex Technical Support� XE "Technical Support" �

For technical questions, refer to the product online help or users manual. For troubleshooting and reference on often asked questions, refer to the How to Reference at the end of the reference manual or on our Internet Web page.  For questions relating to use of Windows, refer to your Microsoft Windows users manual or Windows Help.



If a problem persists, please follow these instructions before contacting Ivex Technical Support:

Gather all information relating to the problem.

Write down the steps to duplicate the problem and all steps you have taken to correct the problem.

Be sure you know your hardware configuration, memory, graphics card or setup before you call.

Please have your computer on and available when you call.

Have your product registration number in front of you when you call.  It may be found under the Help | Registration menu.  You must have a valid registration number for telephone or fax support.



Ivex will provide technical support for a registered current version of  the product.  For capacity limited versions of the products, telephone support is provided for 30 days starting with your first support call, thereafter it is charged by the minute. 



You can reach us for technical support�XE "technical support"� at Ivex calling between 8:00 AM and 4:00 PM Pacific Time, Monday through Friday. 

Tel:  (503) 531-9443

Fax:  (503) 629-4907

e-mail:  help@ivex.com.

Internet and Bulletin Board Service� XE "Bulletin Board Service" � (BBS)

You can reach the Ivex BBS via modem at (503) 645-0576.  It provides online access to the latest product versions.  There is no charge for the BBS usage, and full user access is granted upon completion of a brief set of questions.  We run at 14,400 and lower baud rates and require a setting of 8 data bits, no parity, and 1 stop bit (8-N-1).



You can also reach our Internet� XE "Internet" � World Wide Web page at http://www.ivex.com.  The Web features Application notes, Technical Notes, How To sections, manual doc files, library parts, and the latest product versions.

Your Comments

We are interested in your comments about this manual.  We would like to improve it, but we need your help to do so.  Comments may be on the topics of:

Missing explanation of an item, Missing references to important keywords, Organization of information, or Inconsistency between program and documentation.

�SYMBOL 70 \f "Wingdings" \s 30��

�NOTE:  Please forward any comments by fax or e-mail directly to our publications department at the fax number listed above or to our e-mail address, pubs@ivex.com.  Please include the page number and publication number.��

�

Chapter 2: Running WinDraft

This chapter shows you how to run WinDraft, create a schematic sheet, and briefly explains the functions of the pull-down menus, the buttons on the toolbars, and other display features.

�XE "Running WinDraft"�

To run WinDraft, open the Ivex group window and double-click with the left mouse button on the WinDraft Schematic Capture icon.  WinDraft displays the WinDraft main window.

To load an existing schematic, follow these steps:

�

�1.	Click with the left mouse button on File located in the upper left corner. The File pull-down menu displays.

2.	Click on Load. The Open File dialog box displays.

3.	Select Schematic (*.SCH) in the List Files of Type list box: all the schematic file names display in the Filename list box.

4.	Select a schematic filename.

5.	Click on OK with the left mouse button to load the schematic file.��

	�

		Figure 2-1: The File to Open dialog box.



��To start a new schematic, follow these steps:�XE "creating a new schematic"�

Click with the left mouse button on File.  The File pull-down menu displays.

Click on New.  The New dialog box displays.

Click on the Sheet radio button to create a new schematic sheet file.

��	�

	           Figure 2-2: The New dialog box.

4.	Click in the Name text entry box and enter the name of the new sheet file.  The filename is limited to twenty-one characters (use a maximum of eight characters for Windows 3.1).�XE "file name limitations"�  Use the three character file extension ".SCH"�XE ".SCH extension"� for all WinDraft sheet files.  You do not need to add the file extension, WinDraft will do this automatically.

5.	Select OK to close the dialog box and open the new sheet.

Exit

The Exit command quits the program.

�symbol 70 \f "Wingdings" \s 30���NOTE: The current configuration settings are automatically saved in the ivex.ini file.  This file is located in the Windows directory.��Most Recently Used Files List

The files listed at the end of the File menu represent the most recently saved files. This list provides quick access to recently used files without requiring the user to navigate through a set of menus and dialog boxes to specify the location of the files. The maximum number of files in the list is five.



Example:  If the last sheet you work on is named mysheet.sch it will be at the top of the MRU list in the File menu.

Before				After

New��New��Load��Load��Save Config��Save Config��Exit��Exit��sheet1.sch��mysheet.sch��sheet2.sch��sheet1.sch��sheet3.sch��sheet2.sch����sheet3.sch��Display Features�XE "Display Features"�

After you open a schematic file, a library file or a template file, the WinDraft screen displays.

	

������

 Figure 2-2: The WinDraft Display Screen.



The Windows-based user interface gives you direct and intuitive ways to navigate applications and files, and customize your design environment.

Menu Bar�XE "Menu Bar"�

The  Menu Bar is the menu at the top of the screen.  WinDraft has eight pull-down menus: File, Edit, Place, Tools, Utilities, Properties, Window and Help.



To display the menu, either click on the menu use the Windows accelerator keys (Alt+First Letter).  Each menu has an associated Pull-Down menu.  Scroll down to the desired item and click or press its underlined mnemonic character on the keyboard.  Some individual menus display cascading menus and options, or open dialog boxes.

Tool Bars

�		The Main Tool Bar

��

The Second Tool Bar

WinDraft two toolbars are shown above. The main toolbar, as shown above, runs across the WinDraft window below the menu bar. You can switch on/off the main toolbar by selecting the Properties | Toolbar On/Off command. 



The second toolbar is below the first.  It is composed of buttons used to manipulate the view of the current sheet file, scale selection and it includes an X,Y coordinate display.  This is also known as the Window Tool Bar because it is always attached to the sheet.



The main toolbar icons are detailed in the following table in the order they appear in the toolbar:



��Help���Open File����Save File���Print���EMBED HJPRO \s  \* mergeformat��EMBED HJPRO \s  \* mergeformat�����Wire��EMBED HJPRO \s  \* mergeformat��EMBED HJPRO \s  \* mergeformat�����Bus����Junction��EMBED HJPRO \s  \* mergeformat��EMBED HJPRO \s  \* mergeformat�����Module Port���EMBED HJPRO \s  \* mergeformat����Text��EMBED HJPRO \s  \* mergeformat����Sheet Net���EMBED HJPRO \s  \* mergeformat����Power��EMBED HJPRO \s  \* mergeformat����No Connect���EMBED HJPRO \s  \* mergeformat����Line��EMBED HJPRO \s  \* mergeformat����Circle���EMBED HJPRO \s  \* mergeformat����Rectangle���Find Text����Repeat���Block Cut����Block Copy���Block Paste��������Changing the wire and the line geometry

���Run ERC����Undo���Setup��The second toolbar icons are detailed in the following table in the order they appear in the toolbar :



��Zoom Out���Zoom In����Center Screen���Zoom Best����Refresh Screen���Zoom Window��



Zoom Scale and Grid List Boxes�XE "Scale and Grid List Boxes"�

���The Zoom scale and Grid displacement list boxes located on the right of the second toolbar are used to set the drawing scale and the pointer displacement. The displacement can be set to Pin, Small or Free.

Use Pin to place wires on the pin grid.  It will start placing at the nearest grid point.  Always use the Pin setting in WinDraft when placing parts, wires, buses, junctions or labels.

Use Small to draw at one tenth of a pin grid.

Use Free to draw at one hundredth of a pin grid (off grid).  This is useful for making mechanical drawings using circles, lines and rectangles.  This should not be used for drawing schematics, it could result in wires not being connected.��

To change the scale or the displacement, click with the left mouse button on the scroll arrow to the right of the scale or dispacement list box. A pull-down list displays. Select the option by clicking on it. 

Pin Count

��The current Pin Count for the selected open window displays on the right of the second tool bar.  The total pin count for all open windows is in the Utilities | Statistics menu.  Use the menu selection Help | About to determine the licensed pin capacity of the program.  Unlimited pin capacity indicates there is no program limit on the design size.��

Pointer Coordinates�XE "Pointer Coordinates"�

��The current X and Y pointer coordinates display on the right of the second tool bar.  The incremental value is 1/10 mil.  If your display does not show the entire X, Y coordinates, you are probably using a VGA driver.  Change to SVGA (800 x 600), this will greatly enhance your system performance and usability.��X,Y Display Coordinates�XE "X,Y Display Coordinates"�

WinDraft point of origin (0,0) is at the top left corner of the WinDraft drawing area.

�embed Word.Picture.6 ���

Figure 2-4: WinDraft's coordinates system

All WinDraft locations are specified with positive (x,y) numbers.

Title Bar�XE "Title Bar"�

The title bar is the bar across the top of a window that contains the name of the sheet, library or template.  To move the active window, click on the title bar with the left mouse button and drag the title bar to the desired location.  You can also move the window by selecting Move from the Control menu.

Scroll Bars�XE "Scroll Bars"�

Scroll bars allow the mouse user to move horizontally and vertically through a window. The position of the scroll bar indicates the relative position of the displayed data inside the window : 

¨	To scroll quickly to another part of the document, drag the scroll button.

¨	To scroll one portion of the document in a given direction, click the arrow at the end of the bar.

¨	To view the entire document, hold down Shift while you drag the scroll button.

Status Bar�XE "Status Bar"�

At the bottom of the window, the status bar displays information about the current state and mode of WinDraft.

From left to right :

¨	The first box briefly describes the chosen command.

¨	The second box displays the current Mode (Main Mode, Edit Mode ...).

¨	The third box is the Message Bar.

¨	The fourth box is used for optional messages.

�

Figure 2-5 : The Status Bar

Floating Icon Menu�XE "Floating Icon Menu"�

�EMBED HJPRO \s  \* mergeformat���

�WinDraft’s Floating Icon Menu provides a convenient shortcut that can speed drawing and placement. The Floating Icon Menu contains 14 icon buttons.  Many of these buttons are shortcuts for Place commands. You can switch this on/off by selecting Properties | Show Icons Menu command.

The icon buttons that are not on the main toolbar and are unique to the Floating Menu are listed below.

�  Place No Connect symbol

�  Place Gnd symbol

�  Repeat��Properties and Setup�XE "Properties and Setup"�

��The Properties menu is used to define system settings. This menu contains the menu selections shown in the pull-down menu at left and includes Setup.

The Setup�XE "Setup"� command allows you to set all the WinDraft parameters and user options. 

Select Setup in the Properties menu.  The Setup dialog box displays with eight tab selections.��

�

Figure 2-6 : The Setup dialog box tabs.

The Setup Preferences have been preset.  For instructions refer to the online help or the reference manual.  The Ivex programs are project oriented, therefore if you need to change the file path settings, refer the following instructions for File Locations.

File Locations�XE "Environment"�

The File Locations  selection tab specifies the directory setup and the file extensions. Use the Setup | File Locations command to configure where WinDraft saves and loads files.

		�

			Figure 2-7: The Environment dialog box.

Directories entry boxes�XE "Directories entry boxes"� :

·	Current Project Path:  Sets the WinDraft project files directory. The default directory is ..\demo (\ivex\demo).

·	Current Library Path�XE "Library Files"�:. Sets the WinDraft binary and ASCII library files directory. Default is .\LIBRARY (\WINDRAFT\LIBRARY).



Use Delete to remove a listing from the Project Path box or the Library Path box.  For additional information, refer the the WinDraft Reference manual.



Window�XE "Window"�

�EMBED HJPRO \s  \* mergeformat����The Window menu contains commands that re-arrange and re-size the windows in WinDraft. As the user opens new parts, libraries or templates, the windows can overlap and eventually hide one another.  The user needs a way to arrange the window so that all the windows are at least partially visible. This can be done in a variety of ways :��

Cascade�XE "Cascade"��Arranges the windows in overlapping style.��Tile�XE "Window:Tile"��Arranges the windows in a tiled style, with each window displayed in its own space within the WinDraft main window.��Arrange Icons�XE "Window:Arrange Icons"��Arranges the icons in the main WinDraft window.��Next�XE "Window:Next"��Is used to activate the following part , library or template window loaded in the main WinDraft window.��

The window titles list allows the user to activate any loaded window.  When the user selects one of the titles, the currently active window is deactivated, and the selected window is activated displaying on top of the other ones. 

Help�XE "Help"�

��

Help contains the menu selections shown in the Help pull-down menu at left.  This menu works similarly to the Help pull-down menu in other Windows-based applications.  ��Index�XE "Cascade"��Displays the cross-referenced topics available in the WinDraft Help system.��Topic Search�XE "Window:Tile"��Table of contents of WinDraft Help system.��Using Help�Displays the Help usage.��Shortcuts�XE "Window:Arrange Icons"��Lists shortcut keys available in WinDraft.��Tips�Shows Tips of the day.��Registration�Enter the password registration number.��About WinDraft�XE "Window:Next"��Displays the version number, copyright and pin capacity of WinDraft.��

�Chapter 3:  Running WinBoard

This chapter shows you how to run WinBoard, create a new board, and briefly explains the functions of the pull-down menus, the buttons on the toolbars, and other display features.

� XE "Running Ivex PCB" �

To run WinBoard, open the WinBoard group window and double-click with the left mouse button on the WinBoard Layout icon. WinBoard displays the WinBoard Layout window. To create a new board file�XE "Loading:Existing board file" \b�, follow these steps:



�EMBED PBrush \s  \* mergeformat��EMBED PBrush \s  \* mergeformat�����1.	Click with the left mouse button on File. The File pull-down menu shown at left displays.

2.	Click with the left mouse button on New Board. The New Board dialog box �XE "New Board dialog box " \b�shown next.

	��		�

	     Figure 3-1: The New Board dialog box�XE "New Board dialog box" \b�.

Next, select the number of layers you want the board to have. The board may have as many as sixteen layers.  If you are not sure, you may add or delete layers at any time.  Each layer has a name. By default, layer one is the solder layer. Layer two is the component layer.

4. 	Press OK.

Layers and Names

WinBoard has a minimum of 2 layers and a maximim of 16 layers.  If you want to do a one layer board� XE "one layer board" �, select 2, then only put copper connections on one layer.  

When viewing board layers, the bottom layer is always the solder side and is layer one.  The last or largest numbered layer is the component layer.



�XE "Layer Names:changing"\b�If you wish to change the layer names, follow the steps below:

1.	Click with the left mouse button on the Layer Edit �XE "Layer Names " \b�button in the New Board dialog box�XE "New Board dialog box" \b�. The Layer Edit dialog box shown next displays.

		�

	            Figure 3-2: Layer Edit dialog box�XE "Layer Names:dialog box" \b�.

2.	Press the left mouse button and hold it while dragging the pointer across the text in the text entry box next to the layer number you want to rename.

3.	Enter the new layer name.

4.	Repeat steps two and three for each layer you want to rename.

5.	Click OK to accept the changes you have made.

The display features of the main WinBoard screen are explained in the next section.

Display features

After you open a board file, the WinBoard Layout screen displays as follows :

	�

     Figure 3-3: The WinBoard screen with floating X Y coordinate box�XE "WinBoard PCB Layout screen" \b�.

Menus

WinBoard has eight pull-down menus: File, Edit, Place, Tools, CAM, Utilities, Window, and Help.  You need only click once on the left mouse button to use the pull-down menus.

Help�XE "Help"�

��

Help contains the menu selections shown in the Help pull-down menu at left.  In addition to the Help functions, this also contains Key Commands, X Y Window, Resistration and About the program.��Key Commands�XE "Cascade"��Use this to display a pop-up dialog box with reference of keyboard shortcuts and function keys.��X Y Window�XE "Window:Tile"��Use this to display a floating dialog box with the X and Y coordinates.  Useful if you use VGA display mode.��Registration�Enter the password registration number.��About WinBoard�XE "Window:Next"��Displays the version number, copyright and pin capacity of WinBoard.��Toolbars� XE "Toolbars" �

�

				Figure 3-4 : The WinBoard Toolbars



WinBoard's two toolbars are shown above. The main toolbar �XE "main toolbar " \b��XE "toolbar:main" \b�runs across the WinBoard window below the pull-down menus. The secondary toolbar �XE "secondary toolbar " \b��XE "toolbar:secondary" \b�is below the first, and is composed of six buttons used to manipulate the view of the board file on the display. 

To set the parameters for WinBoard tools, just click with the left mouse button on a button and the dialog box for that tool displays. 

�EMBED PBrush \s  \* mergeformat���	�EMBED PBrush \s  \* mergeformat�����EMBED PBrush \s  \* mergeformat���	�EMBED PBrush \s  \* mergeformat����Begin routing �XE "Begin routing "\b��XE "Routing Begin"\b�simply by pressing the r key. The Track, Outline & Edge button changes appearance depending on the current style of routing angle. The four different button styles are shown at left in the following order: 45 degree, arc, any angle, and 90 degree. Change routing parameters with a single click of the left mouse button on the Track, Outline & Edge button.��Scale and Units



��The Scale selection box is shown at left.  There a two boxes, one is used to display the zoom scale and the other to select the unit (mil, mm, um).��Scale� XE "Scale" �



��The box at left contains the zoom selections available.  Click on the arrow with the left mouse button to open the pull-down box.  Then click on the zoom selection.

Each number represents the number per pixel.  For example, if the grid unit is mils, 2 represents 2 mils per pixel, 50 represents 50 mils per pixel.

You may also use the Home and End keys on the keyboard to zoom in and out respectively.  This is the easiest way to zoom in and out while routing.��Units� XE "Units" �



��The Units selection box is shown at left.  Click on the arrow with the left mouse button to open the pull-down box.

Click on the desired unit.  The three choices are:

1.  mil:  mils.  

2.  mm:  millimeters.

3.  µm:  microns.��

A micron represents one millionth of a meter.  The programs internal database has a resolution of 1 micron, or .001 millimeters.

Grid



��The Grid� XE "Grid" � selection box is shown at left.  Click on the arrow with the left mouse button to open the pull-down box.

Click on the desired grid setting to use for routing.  

To route off grid� XE "Grid:off grid" �, click in the box next to the G so that it is blank.��Track Color Indicator�XE "Track Color Indicator"\b�

�EMBED PBrush \s  \* mergeformat��EMBED HJPRO \s  \* mergeformat�����The track color indicator located to the right of the grid list box shows the color of tracks on the active layer. You can change the track color settings with the Setup tool. For more information about color settings, see the description of the Setup in the online help.��Layer Name Indicator�XE "Layer Name Indicator"\b�

�EMBED HJPRO \s  \* mergeformat����The layer name indicator located to the right of the track color indicator shows the name of the active layer. You can give each layer a name when you first create a new board file or change the layer name at a later time with Layer Edit in the Setup tool. For more information about naming layers, see Changing Layer Names at the beginning of this chapter.��X and Y Pointer Coordinates�XE "X and Y Pointer Coordinates"\b�

�EMBED MSDraw   \* mergeformat���EMBED HJPRO \s  \* mergeformat����The current X and Y pointer coordinates display to the right of the layer name indicator. You can use the Units pop down menu on the second toolbar to change the kind of units used to display the current pointer coordinates. If you have any problem displaying the x,y coordinates, check your Windows setup for the correct display configuration, SVGA 800 x 600 or higher is recommended.��Layer Number Buttons�XE "Number Buttons"\b�

��To the left of the drawing area is a column of buttons containing numbers. These buttons are the Layer Number buttons. The button for the layer currently available for editing is white, while all other buttons are red if selected for routing, and gray if unselected (see Routing Layers). 

Click with the left mouse button on the layer number button that matches the layer you want to edit. 

��Routing layers� XE "Routing layers" � (layer pairs� XE "layer pairs" �)

The Layer buttons are also used to select which ones to toggle through.  This enables you to select only the layers you want active so you may select layer pairs for routing.  By making this selection, the program will only toggle through the enabled layers when using the V key to drop a via� XE "Via" �.  

The program defaults with the top and bottom layers selected (red).

Follow these steps:

Hold down the Shift key on the keyboard and click on the layer button with the left mouse button.

The layer number will change from black to red, indicating that the layer is active.  Continue to select other layers in this same manner.

Now, when you press the V key the program will toggle through the selected layers.  When you are routing, it will allow you to select layer pairs for routing, for example: 

On a six layer board, select layer 1 and layer 2 for routing layers.

Start routing on layer 1 and place a via using the V key.

The program will place a via and switch to layer six without having to toggle through layers 2-5.

On a layer button that is already red, hold down the Shift key and click on the layer button to deselect, it will change to black.

�SYMBOL 70 \f "Wingdings" \s 30��

�NOTE:  You may also use the + or - keys on the keyboard to change layers, or Page Up and Page Down.   These keys will toggle through All layers on the board regardless of the routing layers selected.��Display layer� XE "Disable layer" �

To keep a layer from displaying, hold down the Ctrl key and click on the number button with the number of the layer you want to keep from displaying. If you later want to display a layer for which you have disabled display, simply click once with the left mouse button on the number button with the number of the layer you want to display.  Use the Setup | Color to change select the color you want to use for a disabled layer, the default color is gray.

WinBoard Quick Start � XE "Start" �

If you have experience with electronic PC board design, and are in a hurry to get started designing your first WinBoard PC board, this Quick Start section will help get you started. 

If you need more information about running WinBoard, refer to the Tutorial or the Reference Guide.

Placing Modules� XE "Placing Modules" �

There are two ways to place modules:

1.	By loading them from a netlist.

2.	By loading them with the Module tool.

If you want to load modules from a netlist, refer to Loading Netlists.

If you want to load modules manually, use the Module toolbar button, or choose Place | Load Module from the menu.

Routing Tracks�XE "Routing Tracks"\b��XE "Tracks:Routing"\b�

To start routing mode, click with the left mouse button on the Track, Outline & Edge button or simply press the r key. The pointer changes to: �EMBED PBrush \s  \* mergeformat���, signifying that WinBoard has entered routing mode. Refer to figure 2-12.

	�

				Figure 3-5: Routing mode�XE "Routing mode"\b�.

You may route directly with the  mouse, just click on a pad with the left mouse button and continue using the left mouse button to place track segments.  To complete a route, press the right mouse button. Use the keyboard shortcut keys while routing to change styles.  For example:  press the S key to mirror the track or the X  key to toggle through styles.

To use the pop-up routing menu, go to Setup and deselect the box Route with Left Mouse Button.



		�

		    Figure 3-6:  The Setup dialog box.



To change layers before beginning to route a track, press the + on the numeric key pad for each layer higher you want to go or - on the numeric key pad for each layer lower you want to go.

To begin routing, follow these steps:

1.	Place the pointer on the pad from which you want the track to begin and press b, for begin. The pointer changes to: �EMBED PBrush \s  \* mergeformat���, signifying that WinBoard is ready to continue placing track segments. Refer to figure 2-14.

2.	As you move the pointer, notice that there is a white track attached to the pointer and that the ratsnest attached to the pad (if you are using a netlist) from which you are routing moves with the pointer.

The white track shows the actual size the track will be. Notice that there are also colored lines on both sides of the track. These colored lines are the routing guard and are the same color as the track color for the layer you are routing on. The routing guard surrounds the white track to show the clearance limits (isolation) for the track you are routing.

�EMBED PBrush \s  \* mergeformat���	�EMBED PBrush \s  \* mergeformat�����EMBED PBrush \s  \* mergeformat���	�EMBED PBrush \s  \* mergeformat����If necessary, click on the Track, Outline & Edge tool, shown at left, to change the clearance limits in the Track, Outline & Edge dialog box. For more information about the Track, Outline & Edge tool, refer to the Reference manual.��

If you prefer to route the tracks without seeing the clearance limits, remove the X from the Guard check box in the Track, Outline & Edge dialog box.

�

	     Figure 3-7: Track placement mode�XE "Track placement mode" \b�.

3.	Move the pointer to where you want the next vertex and press b to begin (or click once on the left mouse button) the next track segment. For more information on key commands, refer to the table following figure 2-15.

4.	Continue placing the track as in step three above until you come to the location where you want to end the route. 

�SYMBOL 70 \f "Wingdings"��NOTE: To refresh the screen at any time, press the Z key.��End the route by following these steps:

1.	Press n to end the track or press the right mouse button once. WinBoard remains in routing mode so that you can continue routing tracks. Refer to figure 2-15 to see a completed route. 

2.	To exit routing mode, press Esc or click the right mouse button.

	�EMBED HJPRO \s  \* mergeformat���

		Figure 3-8: The Completed track.

There are three methods available for placing tracks:

Using single key keyboard commands to tell WinBoard how to place tracks as explained in the steps above.

You can change the style of track as needed as you place the track and use any combination of styles in a single track.  Refer to the table below for the key commands and their functions:



Key�Command Description��r�Route a track with Track, Outline & Edge routing mode.��b�Begin or continue placing vertices when placing a track, outline, or edge.��n�End a track, outline, or edge with the n key. WinBoard remains in the placement mode so you can continue placing tracks, outlines, or edges.��Back�space�Backtrack or undo a segment while placing a track, outline, or edge.��c or -�Change to the next lower numbered layer and place a via while routing a track by pressing c. Repeatedly pressing c will continue to change layers until the solder side is reached.��v or +�Change to the next higher numbered layer and place a via while routing a track by pressing v. 

Pressing v will toggle through selected layers indicted by the red layer markers.��s�Change the style while placing a track, outline, or edge. s mirrors the current track, outline, or edge segments around the location of the pointer. ��w�Display the Track Parameter� XE "Track Parameter" � dialog box while routing a track by pressing w The Track Parameter dialog box makes it possible for you to change:

1.	The track width� XE "width" � of the track segments after the current vertex.

2.	The via diameter of all of the vias associated with the track after the current vertex of the track.

3.	The drill size of all of the vias associated with the track after the current vertex of the track.��x�Toggle through the routing style with x: 45�SYMBOL 176 \f "Symbol"�, 90�SYMBOL 176 \f "Symbol"�, any angle, and arc. Each time the x key is pressed, the Track, Outline & Edge button changes to reflect the current routing angle or arc.���EMBED PBrush \s  \* mergeformat��EMBED PBrush \s  \* mergeformat�����2.	Use the commands on the pop-up menu to tell WinBoard how to place tracks—the pop-up menu looks similar to the menu shown at left.

You select the options from the pop-up menu either by clicking on the option you want or by pressing the key on the keyboard that is underlined in the pop-up menu option.

Select Begin to begin routing a track.

Select End to end a track.

Select Layer �XE "Layer: changing while routing" \b�if you want to insert a via and change the layer on which you place the remainder of the route.

Select Restart �XE "Restart:while routing" \b�to change routing layers immediately after beginning a new track. If have just begun routing a track and select Restart, a pop-up menu lists all the available layers. When you click with the left mouse button on the layer on which you want to route, the route outline changes color to match the color of the new routing layer.��Select Style �XE "Style: changing while routing" \b�to change the style while routing. Style mirrors the current track segments around the location of the pointer. 

Select 90 deg for a track with 90 degree style.

Select 45 deg for a track with 45 degree style.

Select Any Angle for a track with any angle style.

Select Arc for a track with arc style.

Select Backtrack �XE "Backtracking: while routing" \b�to undo the last placed segment. You can backtrack all the way to the beginning of the current track. You can even backtrack a parked route from the parked location. A track is parked �XE "parked route" \b�if the track ends at a location that is not the ratsnest destination. 

�SYMBOL 70 \f "Wingdings"��NOTE: The only time you cannot backtrack a route all the way is if the track is in the form of a T.  If the track was routed in the form of a T, the only direction in which you can backtrack is the direction in which the track was originally routed from.��To backtrack a parked route�XE "backtracking:parked route" \b�:

While in track routing mode, click with the left mouse button on end of the parked route that was placed last. The track routing pop-up menu displays.

Click with the left mouse button on Backtrack. The last segment of the track disappears.

Select escape to stop placing tracks.

Route with the mouse (left mouse button).  This is the Default mode.  The keyboard commands described above may also be used while routing using the mouse.



�SYMBOL 70 \f "Wingdings"��NOTE: Tracks, board edges, and zone outlines are placed in a similar manner. For simplicity, this section explains how to place tracks. You can use the same methods to place board edges and zone outlines.��Changing Routing Parameters�XE "Routing Parameters:Changing" \b�

If you need to change the routing parameters while in routing mode press the x key on the keyboard, or follow these steps:

�EMBED PBrush \s  \* mergeformat���	�EMBED PBrush \s  \* mergeformat�����EMBED PBrush \s  \* mergeformat���	�EMBED PBrush \s  \* mergeformat����1.	Click with the left mouse button on the Track, Outline & Edge button. The Track, Outline & Edge button changes appearance depending on the chosen style of routing angle. The four different button styles are shown at left in the following order: 45 degree, arc, any angle, and 90 degree. The Track, Outline & Edge dialog box displays as shown in figure 2-16.��		�

		     Figure 3-9: The Track, Outline & Edge dialog box.

2.	Make the necessary changes to the Track, Outline & Edge parameters.

3.	Click OK. The main WinBoard screen displays again.

Selecting Objects�XE "Selecting Objects" \b�

This section explains how to select objects. Modules are selected differently than other objects. The methods for selecting objects of any type are:

�SYMBOL 183 \f "Symbol" \s 10 \h�	As blocks of objects

�SYMBOL 183 \f "Symbol" \s 10 \h�	As single objects

Selecting Blocks of Objects�XE "Selecting:Blocks of Objects" \b��XE "Blocks of Objects:Selecting" \b�

To select a block of objects, follow these steps:

1.	Place the pointer at one corner of the area you need to select. 

2.	Press and hold the left mouse button while dragging the pointer to the opposite corner of the area to be selected. WinBoard draws a dashed box around the area that is selected.

3.	Release the left mouse button to complete the selection process. All objects within the rectangle are now selected. 

When you release the mouse button, the pointer looks like this: �EMBED PBrush \s  \* mergeformat��� and the Block Cut and Block Copy buttons display as active buttons rather than dimmed buttons. Whenever the pointer touches the area surrounded by the rectangle, the pointer looks like this: �EMBED PBrush \s  \* mergeformat���. 

To cut or copy the block of selected objects, use the Block Cut and Block Copy tools. 

To move the block of selected objects, simply place the pointing hand anywhere in the block and hold down the left mouse button while dragging the block of selected objects.

Selecting Modules�XE "Selecting Modules" \b��XE "Modules:Selecting" \b�

To select a module, click the left mouse button on any pad that is part of the module. WinBoard highlights the module.

Select more modules along with the one you have already selected by holding down the Ctrl key while clicking with the left mouse button on a pad in each module.

To unselect selected modules, click with the left mouse button on no object.

Selecting Part of a Module�XE "Selecting Part of a Module" \b��XE "Part of a Module:Selecting" \b�

To select any object other than a pad that is part of a module, hold down the Ctrl key while clicking with the left mouse button on the object you want to select. Select more objects that are part of a module in the same manner.  For example, to select module text� XE "select module text" �� XE "Text Editing:select module text" � (Part Ref or Part Val) hold down the Ctrl key and click on the text with the left mouse button.

To select one or more pads that are part of a module, hold down the Ctrl and Shift keys while clicking with the left mouse button on the pad or pads you want to select.

Selecting Objects Other Than Modules�XE "Selecting Objects Other Than Modules" \b��XE "Objects Other Than Modules:Selecting" \b�

The methods for selecting objects other than modules are:

1.	Select a single object by clicking on the object with the left mouse button. WinBoard highlights the object.

2.	If you want to select more objects along with one you have already selected, hold down the Ctrl key while clicking on each object.

�SYMBOL 70 \f "Wingdings"��NOTE: To unselect all objects, click again on another object or on no object.��Editing �XE "Editing Objects" \b�Objects Other than Modules

WinBoard provides powerful, flexible editing features. 

Editing any object other than a module is as simple as double-clicking on the object with the left mouse button and selecting the appropriate characteristics from a dialog box, then selecting OK. 

For example, if you want to change a dimensioning arrow from external to internal, follow these steps:

1.	Place the pointer on the dimensioning arrow you want to change and double-click the left mouse button. The Dimensioning dialog box displays.

2.	Click with the left mouse button on the Internal radio button and click OK.

Editing �XE "Editing Modules" \b�Part of a Module

Editing part of a module is as simple as holding down the Ctrl key, double-clicking on the part of the module with the left mouse button, and selecting the appropriate characteristics from a dialog box, then selecting OK.

For example, if you want to edit module text� XE "edit module text" �, follow these steps:

1.	Press and hold the Ctrl key.

2.	Place the pointer on the text you want to change and double-click the left mouse button. The Text dialog box displays.

3.	Make the desired changes to the text and click OK.

Editing Tracks�XE "Editing Tracks" \b�

WinBoard's track editing features make it simple for you to move a whole track, drag single vertices, delete single vertices, insert new vertices anywhere on a track, drag a segment of track, drag three adjacent track segments simultaneously, and drag a whole track without moving the beginning and ending points.

This section explains how to drag a track to a new location, insert a new vertex, and drag a vertex to a new location.

Dragging� XE "Dragging" � a Single Track Segment to a New Location

To drag a single segment of track to a new location, follow these steps:

1.	Select the track you want to change by clicking on the track with the left mouse button. WinBoard highlights the track.

2.	Press and hold the Ctrl key. As you move the pointer near the center of any single segment of the selected track the pointer changes as shown in figure 2-17, signifying that WinBoard has entered the mode to drag a single segment of track.

	�

	    Figure 3-10: A selected track with the drag pointer displayed.

To drag the track segment, follow these steps:

1.	Place the �EMBED PBrush \s  \* mergeformat��� on the segment of track you want to move.

2.	Press and hold the left mouse button and drag the track segment to its new location.

3.	Release the left mouse button. The track remains selected so you can perform more edits if you like.

Inserting a New Vertex�XE "Vertex:Inserting New" \b�

To insert a new vertex, follow these steps:

1.	Select the track you want to change by clicking on the track with the left mouse button. WinBoard highlights the track.

2.	As you move the pointer near a single segment of the selected track the pointer changes as shown in figure 2-18, signifying that WinBoard has entered the mode to insert a new vertex.

		�

	   Figure 3-11: A selected track. Insert vertex pointer displayed.

3.	Place the � on the segment of track exactly where you want to add the vertex.

4.	Click the left mouse button. The pointer changes to look like this: � to indicate that the vertex has been added.

Dragging a Single Vertex to a New Location

To drag a single vertex of track to a new location, follow these steps:

1.	Select the track you want to change by clicking on the track with the left mouse button. WinBoard highlights the track.

2.	As you move the pointer near any vertex of the selected track the pointer changes as shown in figure 2-19, signifying that WinBoard has entered the mode to drag a vertex.

		�

	   Figure 3-12: A selected track. Drag vertex pointer displayed.

3.	Place the � on the segment of track you want to move.

4.	Press and hold the left mouse button and drag the vertex to its new location.

5.	Release the left mouse button. The track remains selected so you can perform more edits if you like.

Printing and Gerber

To Print� XE "Print" �, select File | Print.  This will open the Print/Plot dialog box.  Press the Layer Selection button to select the layer to print, and press the Object Selection button to choose the objects to print.  Press the Preview button to view the board before printing, then press the Print button to print.  For more information, refer to Printing in the Reference manual or in the online help.

�

Figure 3-13: The Print/Plot dialog box.



To generate a Gerber� XE "Gerber" � photo plot� XE "photo plot" �, select Photo Plot in the CAM menu.  Choose the objects to print and the layer.  Press the Setup button to open the Gerber Setup dialog box.  Press the Plot button and enter the name of the file in the Save Gerber Plot File dialog box.  For more information, refer to Gerber in the Reference manual or in the online help.

�

Figure 3-14: The Gerber Setup dialog box.�Chapter 4:  WinDraft Tutorial

Purpose:

This chapter is designed to teach you how to create a schematic, title block and then output a netlist to be used in a PCB application.

Overview:

This chapter covers the following items:

Placing, rotating and moving parts

Drawing wires

Placing junctions, text and power symbols

Creating and placing a title block

Annotation

Creating a bill of materials report

Using the Electronic Rule Checking feature to verifying the schematic’s electrical integrity 

Outputting a netlist file to be used in a PCB application or simulator

Printing the schematic

STEP #1: Creating the RADIO Schematic

This section step you through the process of creating a three transistor radio. The schematic will look like Figure 1:

� EMBED Word.Picture.6  ���
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1.1: Creating a new Schematic:�XE "Tutorial:Creating the RADIO Schematic:Running the WinDraft Schematic Editor"�

Click on the FILE | NEW menu item. The following dialog box will be displayed:

�

Click on the Sheet radio button.

Type in the word RADIO into the Name field.

Click on the OK button. WinDraft will automatically add the .SCH file extension to the filename.

1.2:  Placing Parts

�symbol 70 \f "Wingdings" \s 30��

� EMBED Paint.Picture  ����NOTE: Check the Grid setting. It should be on Pin. The Grid setting is in the second toolbar. You should never place parts, wires, buses, junctions, no-connect, module ports, sheet nets, power symbols on the Small or Free grid settings. These two grid settings are for placing drawing objects such as lines, circles and boxes.

����Click on the Part icon from the main toolbar, or click on the PLACE | PART menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Click on the DEVICE.CLB option in the Library listbox. All the parts in this library will now be listed in the Parts listbox.

Click on the BATTERY part in the Parts listbox. The selected part in the Parts listbox will be displayed in the display field in the lower right hand corner of this dialog box.

Click on the OK button. This will close the dialog box and bring you back to the schematic. You will notice the BATTERY part attached to the end of the mouse pointer.

Press the RIGHT ARROW key once. This will rotate the part 90 degrees to the right.

Move the mouse pointer till the X/Y coordinates read x70000 y21000.���Click on the left mouse button once to place the BATTERY part. Notice that after you have placed the part you still have the part attached the mouse pointer. This would allow you to place more BATTERY parts on your schematic.���Click on the right mouse button once to get out of the place part mode.

Follow the above steps 2-8 to place the following parts. You can use Figure 1 as a guide in placing the parts. To skip placing all these parts go to the section explaining how to load the RADIOP.SCH file. After you have placed all the parts, the schematic should look something like Figure 2.��Library�Part�X/Y Coordinates�Rotate��DEVICE.CLB�SW_SPST�x70000 y27000�+90 degrees��DEVICE.CLB�SPEAKER�x64000 y20000�N/A��DEVICE.CLB�NPN�x57000 y35000�N/A��DEVICE.CLB�PNP�x63000 y31000�N/A��DEVICE.CLB�R (4 of them)�(one) x41000 y15000

(two) x50000 y28000

(three) x35000 y35000

(four) x30000 y43000�(one) +90 degrees��DEVICE.CLB�DIODE�x35000 y220000�+90 degrees��DEVICE.CLB�CAP_NP

(3 of them)�(one) x27000 y43000

(two) x42000 y30000

(three) x40000 y43000�(two) +90 degrees��DEVICE.CLB�R_POT

(2 of them)�(one) x50000 y18000

(two) x50000 y43000�N/A��DEVICE.CLB�CAP_VAR�x20000 y43000�N/A��DEVICE.CLB�ANTENNA�x18000 y14000�N/A��RADIO.CLB�COIL�x11000 y28000�N/A��RADIO.CLB�HEP802�x28000 y24000�N/A���
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1.3:  Loading the RADIOP.SCH schematic

��Click on the Load icon in the main toolbar, or click on the FILE | LOAD menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Click on the RADIOP.SCH filename. A Windows shortcut is to double-click on the filename and the file will automatically open. 

Click on the Open button.��1.4:  Saving the schematic

��Click on the Save icon in the main toolbar, or click on the FILE | SAVE menu item. If you did not enter in a filename when you were creating the schematic the following dialog box will be displayed:

� EMBED Paint.Picture  ���

Type in the filename radio into the File name field.

Click on the Save button. WinDraft will automatically add the .SCH file extension to the filename.

If you did enter in a filename when you were creating the schematic then pressing the Save icon will just save the schematic.��1.5:  Assigning Part Values

Double click on the COIL part. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

In the top left hand corner there is a drop down listbox that has the words Part Ref. in it. Click on this drop down listbox and change it to Part Value.

Directly below this drop down list you will see an edit field with the word coil in it. This is the value you will need to change for each of the following parts. Follow steps 1-3 to change the following part values. Replace the word COIL in step 1 for the name of the part you modifying.



Original part values�RADIO Schematic values�X/Y Coordinates��SPEAKER�SPEAKER 45 Ohm�x64000 y20000��ANTENNA�Ext Antenna�x18000 y14000��NPN�NPN�x57000 y35000��PNP�PNP�x63000 y31000��R�100 K�x50000 y28000��R�1 Meg�x35000 y35000��R�4.7 K�x41000 y15000��R�4.7 K�x30000 y43000��CAP NP�.02 uF�x40000 y43000��CAP NP�.01 uF�x27000 y43000��CAP NP�0.1 uF�x42000 y30000��CAPACITOR VAR�365 pF�x20000 y43000��POT�100 K�x50000 y18000��POT�10 K�x50000 y43000��BATTERY�12 V�x70000 y21000��HEP802�HEP802�x28000 y24000��COIL�COIL�x11000 y28000��DIODE�DIODE�x35000 y22000��SW SPST�On/Off�x70000 y27000��1.6:  Moving Part Values and Part References�XE "Tutorial:Creating the RADIO Schematic:Moving Part Values and Part References"�

Each part has a part reference and part value. In Figure 3 the part reference is the T?, and the part value is the HEP802. Sometimes these text fields are not placed in a location that is easy to read them. This section will explain how to move these fields.



�
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��If you have not saved the schematic this would be a good time to do so. ���To move a part value or reference, click once on the text. You will see the text highlight. Click and hold down the right mouse button on the text, then move it to your desired location.

Adjust all the part values and references as shown in Figure 1. Doing this makes your schematic readable.��1.7:  Drawing Wires �XE "Tutorial:Creating the RADIO Schematic:Drawing Wires and Placing Junction"�

�symbol 70 \f "Wingdings" \s 30���Check the Grid setting. It should be on Pin. The Grid setting is in the second toolbar. You should never place parts, wires, buses, junctions, no-connect, module ports, sheet nets, power symbols on the Small or Free grid settings. These two grid settings are for placing drawing objects such as lines, circles and boxes.

���symbol 70 \f "Wingdings" \s 30���NOTE:  If you need to see your work more clearly use the HOME and END keys located on the keyboard to zoom in and out.

����If you have not saved the schematic this would be a good time to do so. If you need to review, go back to section 1.4.����Click on the Wire icon in the main toolbar, or click on the PLACE | WIRE menu item. The mouse pointer will change to look like an arrow pointing to the left with the letter W over it.����Make sure the eighth icon on the toolbar looks like the icon to the right. If it does not, press the X key till it does.

Move the mouse pointer to the top pin of the BATTERY part.���Click once on the left mouse button to start placing a wire from the pin.

Move the mouse pointer until you have reached the top pin of the 100 K variable resistor.���Click once on the left mouse button to connect the wire to the pin on the 100K variable resistor. The BATTERY and 100L variable resistor are now connected via a wire.���Click once on the right mouse button. This will stop placing a wire coming from the 100K variable resistor. You will still be in wire mode.

Follow steps 5-8 to connect the top pin of the SPEAKER part to the wire that connects the BATTERY and 100 K variable resistor (you should connect to the wire at X/Y coordinates x60000 y15000).

Notice that as soon as you intersect the two wires a junction is automatically placed at the intersection.

Continue wiring each connection until your schematic looks like Figure 1���symbol 70 \f "Wingdings" \s 30���NOTE:  While you are wiring, you can use the Backspace key to un-wire already placed segments.

��� EMBED CorelDRAW.Graphic.6  ����CAUTION:  DO NOT place wires or buses across part bodies, module ports, sub-sheets, sheet nets, or power symbols. Doing so makes the objects placed over the part body, module port, sub-sheet, sheet-net or power symbol very hard to select.��1.8: Placing a GND Symbol�XE "Tutorial:Creating the RADIO Schematic:Placing a GND Symbol"�

��If you have not saved the schematic this would be a good time to do so. ����Click on the Power icon in the main toolbar, or click on the PLACE | POWER menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Make sure the Gnd (2) option is selected in the Power Style field.

Make sure the Down option is selected in the Orientation field.

Make sure the Power Name checkbox is checked.

Type in the name Ext Gnd into the Power Name field.

Click on the Add button.���Move the mouse pointer to x20000 y48000 and click once on the left mouse button to place the power symbol.

Click once on the right mouse button then click on the Cancel button to stop placing more power symbols. 

Now place a wire from the Ext Gnd power symbol to the 365 pF cap����If you have not saved the schematic this would be a good time to do so. If you need to review, go back to section #4.���Step #2: Creating a Title Block �XE "Tutorial:Creating a Title Block"�

A title block is a special graphical entity that contains user defined parameters. These parameters can include user name, company name, sheet size and sheet file name. This part will explain how to create a Title Block and place it on our RADIO.SCH schematic.

2.1:  Creating the Title Block

Click on the FILE | NEW menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Click on the Title Block radio button.

Type in the word RADIO into the Name field.

Click on the OK button. WinDraft will automatically add the .TBL file extension to the file.

2.2:  Loading the RADIO1.TBL title block

If you decided to skip creating the Title Block then you can take a look at what it looks like by loading the RADIO1.TBL title block file.

��Click on the Load icon in the main toolbar, or click on the FILE | LOAD menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Click on the down arrow in the Files of type drop down listbox field and select the Title Block (*.tbl) option. Now you will see all the title blocks available to open.

Click on the RADIO1.TBL filename. 

Click on the Open button.��2.3: Saving the Title Block

��Click on the Save icon in the main toolbar, or click on the FILE | SAVE menu item. If you did not enter in a filename when you were creating the title block the following dialog box will be displayed:

� EMBED Paint.Picture  ���

��Type in the filename radio into the File name field.

Click on the Save button. WinDraft will automatically put the .TBL file extension onto the filename.

If you did enter in a filename when you were creating the title block then pressing the Save icon will just save the title block.

2.4: Drawing wires and boxes

�symbol 70 \f "Wingdings" \s 30���NOTE: Check the Grid setting. The grid setting is in the second toolbar. Since you will be placing drawing objects such as lines, boxes and circles you can set it to either Small or Free.

����Click on the Box icon in the main toolbar, or click on the PLACE | BOX menu item.

If you went through the menus then will need to click on the PLACE | STYLE(...) | SOLID menu item. ��� EMBED Paint.Picture  ����If you used the toolbar then you will see the pop-up menu to the left. Select the Solid menu item.

Either way, position the mouse pointer at x2000 y5000 and click once on the left mouse button.

Move the mouse pointer till it is at x46000 y19000 and click once on the left mouse button.

Click twice on the right mouse button to quit the Place Box Mode.����Click on the Zoom Best icon in the second toolbar. This will zoom the workarea so that you can see everything that has been placed on the workarea. Now you can see the box you just placed.����Click on the Line icon in the main toolbar, or click on the PLACE | LINE menu item.

If you went through the menus then will need to click on the PLACE | STYLE(...) | SOLID menu item.��� EMBED Paint.Picture  ����If you used the toolbar then you will see the popup menu to the left. Select the Solid menu item.

Either way, position the mouse pointer at x2000 y10000 and click once on the left mouse button.

Move the mouse pointer till it is at x46000 y10000 and click once on the left mouse button.

Click once on the right mouse button. This will stop you from continuing to place lines, but will keep you in Place Line mode.

Place the remaining lines as indicated in the following table. Follow steps 11-13. After you are finished placing these lines, click on the right mouse button to quit the Place Line mode.�����

Starting Point Coordinates�Ending Point Coordinates��x2000 y16000�x46000 y16000��x10000 y16000�x10000 y19000��x38000 y16000�x38000 y19000��

After you place the lines and the boxes, it should look similar to Figure 4.

� EMBED Word.Picture.6  ���

Figure � SEQ Figure \* ARABIC �4�

2.5:  How to add control items

��If you have not saved the title block this would be a good time to do so. If you need to review, go back to section #3.���Click on the PLACE | CONTROLS... menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Click on the Organization Name item in the Controls listbox.

���Make sure the Internal Font checkbox is unchecked.

� EMBED Paint.Picture  ���

��Click on the Arial option in the Font listbox.

Click on the Regular option in the Font style listbox.

Click on the 12 option in the Size listbox.

Click on the Western option in the Script drop down listbox.

Click on the OK button. This will close the Font dialog box and return you to the Add/Edit Control dialog box.

Make sure the X Mirror, Y Mirror, Boxed and Auto-scale checkboxes are unchecked.

Make sure the right arrow button in the Orientation buttons is depressed.

Click on the Place button. Notice that the control object is attached to the mouse pointer as you move it.

Position the mouse pointer at x19000 y8000 and click once on the left mouse button to place the control.

Click once on the right mouse button to return to the Add/Edit Controls dialog box. 

Continue to place the following controls following steps 2-15. Experiment using the internal font and the other options.

After you have finished placing all the controls click on the Cancel button to close the dialog box.



Control Item�Font Size�X and Y Sizes�X/Y coordinates��Title�12�x1200 y1200�x22 000 y13000��Creation Date�12�x600 y600�x21 000 y15000��Modification Date�9�x600 y600�x20 000 y18000��Revision Code�9�x600 y600�x40 000 y19000��Sheet Size�9�x600 y600�x3 000 y19000��2.6: How to place text

��If you have not saved the title block this would be a good time to do so. ����Click on the Text icon in the main toolbar, or click on the PLACE | TEXT... menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  �����

Type in the words Creation Date into the Text edit field.

Make sure the Auto-Scale and Boxed checkboxes are unchecked.

Make sure the right arrow in the Orientation arrows is depressed.

Make sure the Internal Font checkbox is unchecked.

Click on the Font... button. This will open the font dialog box that was explained in section #5.

Click on the Arial option in the Font listbox.

Click on the Regular option in the Font style listbox.

Click on the 8 option in the Size listbox.

Click on the Western option in the Script drop down listbox.

Click on the OK button. This will close the Font dialog box and return you back to the Add/Edit Text dialog box

Click on the Place button. This will close the Add/Edit Text dialog box.

Move the mouse pointer till the X/Y coordinates are x11000 y15000.

Click once on the left mouse button to place the first text.

Click once on the right mouse button to exit the Add Text mode.

Follow steps 2-14 to place the following test items.



Text�True Type 

Font Size�Internal font 

X and Y Sizes�X/Y coordinates��Modify. Date�8�x600 y600�x10000 y18000��Sheet Size�6�x600 y600�x3000 y17000��2.7:  Finished with the Title Block

��If you have not saved the title block this would be a good time to do so. 

Close the title block by clicking on the FILE | CLOSE menu item.��

The title block is now finished and should look similar to the following example:



� EMBED Paint.Picture  ���
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2.8:  Placing the title block on the schematic

You should already have the RADIO.SCH open, if not, do so now.  Follow the steps in 1.3 of this chapter.



Click on the PLACE | TITLE BLOCK menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Click on the RADIO1.TBL filename.

Click on Open button. The dialog box is closed and you will notice that the title block is attached to the mouse pointer as you move it.

Move the mouse pointer to x53000 y58000 and click once on the left mouse button.

2.9:  Assigning Values to the control Items�XE "Tutorial:Creating a Title Block:Assigning new Values to the Title Block Controls Items"�

Once a title block has been placed on a schematic some of the control items are automatically updated. Such as creation date, modification date, schematic filename and sheet size.

You will have to manual change the values in the other control items. This section explains how to do this:

��If you have not saved the schematic would be a good time to do so. If you need to review, go back to section 1.4.

Double click on the <Organization> control field. The following dialog box will be displayed:

� EMBED Paint.Picture  �����Type in your company name in the Control Value field.

Click on the OK button.

Follow steps 2-4 to set the values for the <Title> and <Rev.> control fields.

2.10:  Finished placing the Title Block

��If you have not saved the schematic this would be a good time to do so. If you need to review, go back to section 1.4.��STEP #3:  Preparing and outputting the netlist.

3.1:  Annotation �XE "Tutorial:Annotating RADIO.SCH"�

The Annotate processor scans the sheet and automatically updates part reference designators. 

Click on the TOOLS | ANNOTATE menu item. The following dialog appears:

� EMBED Paint.Picture  ���

Make sure that Verbose Mode, Unconditional and Keep Device are checked.

Make sure the Descend Hierarchy checkbox is unchecked.

Make sure that no fields in the Fields Combine field are selected.

You do not need to enter in a Output File value because WinDraft will use the current schematic as the filename.

Click on the Execute button to start the annotation.



As it annotates, a log window will be opened that reports all the steps of the annotation. At the end of the process, notice that all the reference designators have been updated in the schematic.

3.2:  Creating the Bill of Materials report �XE "Tutorial:Creating the Bill of Materials for RADIO. SCH"�

The BOM processor creates an ASCII text file listing all the parts in the schematic. It also contains some other very important information about the schematic.

��If you have not saved the schematic this would be a good time to do so. If you need to review, go back to section 1.4.

Click on the UTILITIES | BOM menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

��Make sure the Verbose Mode checkbox is checked.

Make sure the Use Merge File and Descend Hierarchy checkboxes are unchecked.

Make sure that no fields in the Fields Combine field are selected.

Click on the Execute button. WinDraft will use the name of the schematic and add a .BOM extension as the default filename to save the BOM report to.

As it processes, it will opens a log window that reports all the steps of the process. At the end of the process, the ASCII RADIO.BOM file is generated reporting all the parts in RADIO.SCH. A report will be displayed in a windows looking like Figure 6.
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3.3:  Using the Electronic Rule Checking �XE "Tutorial:Verifying RADIO.SCH"�

The ERC processor performs a general check on the schematic. It issues warnings for un-used pins, unconnected wires and invalid connections.



�symbol 70 \f "Wingdings" \s 30���NOTE:  Always run the Electrical Rules Check (ERC) on your designs before running the netlist processor. If errors are reported, correct them before trying to generate a netlist for WinBoard as the results of the layout could be inaccurate.

����If you have not saved the schematic this would be a good time to do so. ���Click on the UTILITIES | ERC menu item. The following dialog box will be displayed:

� EMBED Paint.Picture  ���

Make sure the Verbose Mode checkbox is checked.

Make sure the Descend Hierarchy checkbox is unchecked.

Make sure you have the ERC settings you want. The green boxes mean no message will be generated, yellow boxes mean a warning message will be generated, and red boxes mean an error message will be generated. To change a setting click on the box you want to change the setting for. Each time you click on the box it will rotate between the settings.

Click on the Execute button. WinDraft will use the name of the schematic and add the .ERC extension as the default filename to save the ERC report to.����If you already have the ERC settings you want to use, then all you need to do is to click on the ERC icon in the main toolbar. This will run the ERC with the settings that are in the ERC dialog box.��As it processes, ERC opens a log window to report all the steps of the process. 

At the end of the process, the ASCII RADIO.ERC file is generated reporting all the errors and warnings of the schematic. A window will also be displayed containing the ERC report (see Figure 7).
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Figure � SEQ Figure \* ARABIC �7�

3.4:  Printing�XE "Tutorial:Printing and Plotting RADIO.SCH"�

��Click on the Print icon in the main toolbar, or click on the FILE | PRINT menu item. The following dialog box will display:

� EMBED Paint.Picture  ���

Check and uncheck any of the boxes depending on what you want to print.

If you want the schematic on one sheet then check the Auto Fit checkbox.

Once you are done setting up your options click on the OK button to print.��3.5:  Creating a Netlist File�XE "Tutorial:Creating a Netlist File"�

��If you have not saved the schematic this would be a good time to do so. If you need to review, go back to section 1.4 of the creating a schematic portion of this chapter.���Click on the UTILITIES | NETLIST OUTPUT... menu item. The following dialog box will display:
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��Make sure the Verbose Mode checkbox is checked.

Make sure the Descend Hierarchy checkbox is unchecked.

Make sure the WinBoard item is selected in the Format pull-down listbox.

Make sure the ModuleName item is selected in the Module put down listbox.

Click on the Execute button. WinDraft will use the name of the schematic as the default filename to do a Netlist report on

As it processes, a log window will be displayed that will report all the steps of the process. The ERC processor is run automatically before the execution of the Netlist processor. If an error or warning has been detected, WinDraft asks you for confirmation to continue the netlist.

At the end of the process, the ASCII RADIO.NET file is generated and displayed reporting all the connectivity of RADIO.SCH. A windows is also displayed with the netlist in it (see Figure 8).
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STEP #4:  Creating Library Parts�XE "Tutorial:Creating Library Parts"��XE "Library parts, creating"�

Running the WinDraft Library Editor�XE "Tutorial:Creating Library Parts:Running the WinDraft Library Editor"�

�symbol 70 \f "Wingdings" \s 30���NOTE:  We have already created the library RADIO.CLB.  So, you may want to assign another name such as RADIO2.CLB when creating these parts.  However, in this tutorial, we will refer to the library as RADIO.CLB.

��1.	Select New in the File menu of the main Window.

2.	Select Library in the New dialog box. Enter RADIO in the  Name entry box. Once saved, WinDraft will add automatically the file extension .CLB.

3.	Click on OK. Notice that the library name displays in the title bar.

Creating the HEP802 Part

��XE "Tutorial:Creating Library Parts:Creating the HEP 802 Part"�

Figure 4-9: The HEP802 part

How to place a body

1.	In the secondary toolbar, select Pin in the D: list box to set WinDraft into a "Snap To Pin" mode.

��2.	Click on the Setup  icon button then select Preferences.  Make sure that Show Items Filled is active and select Fine in the Grid Thickness list box.  Click on OK twice to exit the dialog box.��3.	Select Body in the Place menu. Since the transistor HEP 802 contains only one part per device and does not have any converted form, make sure that Device per Pack is set to one and Convert Form is not active.

4.	Click on the Place button.

5.	Adjust the size of the internal body border to make a square by moving the pointer. When the pointer is at (12000, 12000), click on the left mouse button.

�symbol 70 \f "Wingdings" \s 30���NOTE:  The border may not look square on certain computer monitors.

��6.	Zoom in as necessary.  Place the cursor in the box and press the Home key to zoom in.

How to place a circle

��1.	Select the Circle icon button and choose solid.  Position the pointer in the center of the internal body. Click on the left mouse button to set the circle center. ��2.	Adjust the size of the circle to its maximum size in the internal body border. Click once on the left mouse button to place the circle. Click twice on the right mouse button to exit the Place Circle mode.

How to draw lines

1.	Select Small in the D: list box (or click on the D key) to gain finer pointer control.

��2.	Click on the Line button and choose solid.  Fix the start point at the desired location by clicking on the left mouse button. ��3.	To draw an angle or an arc when drawing a line, click on the X key to toggle through 45°, 90°, Arc and Any Angle.

4.	Fix the ending point by clicking on the left mouse button.

5.	Place all the graphical lines of the part as detailed in the above steps. 

6.	Click on the right mouse button to quit the Place Line Mode.

How to place filled polygon

1.	Select Filled Polygon in the Place menu.

2.	Draw the three border lines of the arrow as you would draw lines.

3.	Click once on the right mouse button. WinDraft automatically fills the polygon. 

4.	Click on the right mouse button to quit the Place Filled Polygon Mode.

How to place device pins

1.	Select Pin in the D: list box or click on the D key to snap to grid points.

2.	Select Pin in the Place menu to open the Add/Edit Pin dialog box. Enter D in the Name entry box, 1 in the Reference entry box, select Short in the Shape entry box and select Passive in the Type radio button.

3.	Click on the Add button. Position the pointer anywhere on the body and click on the left mouse button, the pin is highlighted.

4.	Move the pointer to the top right side of the internal part body and click on the left mouse button to place the first pin. 

5.	Click the right mouse button and the Add/Edit Pin displays again to add the second pin. Enter S in the Name entry box, 2 in the Reference entry box. Place the second pin on the bottom right side of the part body.

6.	Repeat step 5 and enter G in the Name entry box, 3 in the Reference entry box, then place the third pin on the center of the left body side.

7.	Click on the Cancel button to close the dialog box.

To edit a pin's characteristics, double-click on the pin. The Add/Edit Pin dialog box displays and proceed to the desired changes. Click on the Change button.

How to add a name to the device

1.	Select Names in the Place menu to open the Part Names dialog box. You can also edit the part name by double-clicking on the name.

2.	Select noname in the Names list box, enter the new name HEP802 in the Name entry box and click on the Modify button.

�symbol 70 \f "Wingdings" \s 30���NOTE: You can assign as many names as needed to the same part by adding names to the Names list box.

��3.	Exit the dialog box.

How to add the reference designator

1.	Select Reference in the Place menu.

2.	Type a T in the entry text box.

3.	Click on the Apply button.



You can edit the part reference by double-clicking on the reference.

Saving the New Library�XE "Tutorial:Creating Library Parts:Saving the New Library"�

��Save the RADIO.CLB library by clicking on the Save icon button. ��Creating the Ferrite Coil�XE "Tutorial:Creating Library Parts:Creating the Ferrite Coil"�

�

			      Figure 4-10: The COIL part

How to create a new part in the RADIO.CLB

Select File | Load 

In the  List of Files entry box select Library (*.CLB)

Choose the library RADIO.CLB in the File name entry box and press OK

Select Part in the File menu. 

Enter Coil in the Selected Part entry box. Click on OK. 

A warning message displays, telling you the part does not exist in the library. Click on OK to confirm the creation of the new part.

How to load a shape from an existing part

1.	Select Get Vector Def from the Place menu. The Get Vector Definition dialog box displays.

2.	Click on DEVICE.CLB in the Libraries list box and click on TRANSFORMER VAR in the Parts list box. Click on the Get button. 

3.	The Get Vector Options dialog box displays. Since the original and the new parts do not have a converted form, not all of the options in this dialog box can be changed. Click on OK and then Cancel to leave the Get Vector Options dialog box. The graphics of TRANSFORMER VAR are loaded on the work-area. 

4.	Select Small in the D: list box or click on the D key to gain sharper pointer control. Use the Home key to zoom in as necessary.

5.	Delete all the left side arcs by selecting each arc (click with the left mouse button) and hitting on the Del key. You can also define a window box around the arcs and hit the Del key to erase all the arcs at once.  Another method to delete consists of holding the Ctrl key and selecting one arc at the time. When all highlighted, click on the Del key. 

How to place device pins

1.	Select Pin in the D: list box or click on the D key to snap to grid points.

2.	Select Pin in the Place menu to open the Add/Edit Pin dialog box. Enter 1 in the Name entry box, 1 in the Reference entry box, select Short in the Shape entry box and activate the Passive check box.

3.	Click on the Add button. Position the pointer anywhere on the body and click on the left mouse button, the pin is highlighted.

4.	Move the pointer to the top right side of the internal part body and click on the left mouse button to place the first pin. 

5.	Click on the right mouse button and the Add/Edit Pin dialog box displays again to add the second pin. Enter 2 in the Name entry box, 2 in the Reference entry box, then place the second pin on the center of the right side.

6.	Repeat step 5 and enter 3 in the Name entry box, 3 in the Reference entry box. Place the third pin on the bottom right side of the part body.

7.	Click on the Cancel button to close the dialog box.

To edit a pin's characteristics, double-click on the pin.  When the Add/Edit Pin dialog box displays, proceed to make the desired changes.  Click on the Change button.

How to add a name to the device

1.	Select Names in the Place menu to open the Part Names dialog box. You can edit the part name by double-clicking on the part name. 

2.	Select noname in the Names list box, enter the new name Coil in the Name entry box and click on the Modify button.

�symbol 70 \f "Wingdings" \s 30���NOTE: You can assign as many names as needed to the same part by adding names to the Names list box.

��3.	Click on Ok to close the dialog box.

How to add the reference designator

1.	Select Reference in the Place menu.

2.	Type an L in the text entry box.

3.	Click on the Apply button.

You can edit the part reference by double-clicking on the reference.

Saving RADIO.CLB�XE "Tutorial:Creating Library Parts:Saving RADIO.CLB"�

��Save the RADIO.CLB library by clicking on the Save icon button. ��Quit the Library Editor by clicking twice on the Controls button at the top left corner of the library window.



�Chapter 5:  Netlists

Netlists� XE "Netlists" � provide the “bridge” between schematics and PCB layout tools.  A netlist is a text file created by WinDraft (or any schematic capture program) that fully describes each part used in the design and how they are connected.  It is the basis for connecting parts once they are placed on the board (PCB layout program).  The data in the netlist includes the reference designator (R1, D7, etc.) part value (220pF, 51 ohm, etc.), and the shape (module footprint) to be used on the printed circuit board (ck05, 14dip300, etc.).



This chapter will go through the steps necessary to produce a netlist from a schematic as follows:



Netname assignment.

Module Name.

Value, Reference and Annotation.

Reports.

Create Netlist.

Other important information.

Netname� XE "Netname" �

Every signal included on the schematic has a net name.  If you do not manually assign one, a net name is automatically generated in the form N00001, N00002, N00003, etc.  To manually assign a net name such as GND for a ground connection, use the Place | Text command and choose Label as the text type. A comment text will not assign a name to the net. Enter the name, such as GND,  in the text entry box.  Place the text label just above the wire you want to assign the net name to.  Refer to WinDraft’s on-line help for more information on placing text.

Power pins� XE "Power pins" � are automatically connected to all other power pins of the same name when you generate a netlist.  You may choose to have power pins visible or not visible, however they are not required to be visible in order to be connected in the netlist.

Net Properties� XE "Net Properties" � to be used in the layout may also be assigned in the schematic and they will then pass forward to the layout program through the netlist.  Net properties include:

Track Width� XE "Track Width" � - the width of the copper trace used to connect module pins.

Isolation� XE "Isolation" � - the required distance between the specified net and all other nets.

Via Size� XE "Via Size" � - the diameter of vias used to connect tracks from layer to layer.

Via Drill Size� XE "Via Drill Size" � - the diameter of the drill hole used to create a via.

To set Net Properties, use the Place | Net Property command.  Enter the values, then press Add.  A small box with the letters NP with an arrow pointer will appear on the screen.  Place the arrow so that is touches the wire (net) you want to assign the net properties to.  Refer to the WinDraft Reference manual for more detailed instructions and examples.

�symbol 70 \f "Wingdings" \s 30���NOTE: Parts, wires, labels and Net Property symbols should be placed using the “Pin” displacement grid� XE "displacement grid" �.  If not, they will be placed “off grid” and it may be difficult to connect wires.  The program will “automatically” connect wires that touch  pins when they are placed on “pin” grid.

��Module Name� XE "Module Name" �

Associated with each part on the schematic is a Module Name. The module name refers to the footprint� XE "footprint" � that will be used for the printed circuit board.  This module footprint is what is used in the PCB layout program to designate the size and shape of each part used on the printed circuit board.  Many WinDraft parts come with a default module name, however it is necessary for the designer to check these and make sure that the value entered is the correct value to use.  Only the designer can determine the correct module footprint to use, the default setting may not be the one you want to use in the design.



The Module Name may be entered during part creation or on the worksheet.  To enter the Module Name for a part, double click on the part in the schematic.  This will invoke the Edit Part dialog box seen in the following example.  In the upper left corner of the dialog box is a pull-down menu that contains the field “Module Name”.  Select Module Name, and then enter the appropriate name in the “Value” entry box.
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It is possible to add or change the module footprint in WinBoard, however it is desirable to have this information in the schematic so that it is contained in the netlist.

How to select a module footprint

You may ask why the program does not do this for you.  Again, even though we may add a default Module Name to a part in the schematic, only the designer (you) can determine which one to use in the design.  

In the example that follows, a single schematic part such as a resistor could have several if not hundreds of possible module possibilities depending on what you are designing.  We have shown four possible modules to use:  An SMD (surface mount device) R1206 and three through hole devices RC05, RC08, and RC12.





Schematic Part�PCB module footprint�������Figure 5-2: Examples of PCB Module names.

If a part has multiple parts per package� XE "multiple parts per package" �, it is necessary to have the exact same module name entered in each of the parts that you want to be able to “package” in the same device.  For example, the TTL part 7400 has four parts per package.  This may be represented by the module footprint 14DIP300, therefore the name 14DIP300 must be entered in each of the four parts.

�symbol 70 \f "Wingdings" \s 30���NOTE:  Many WinBoard modules are from the Jedec Publication #95 and IPC-782 reference books.  Refer to these books for reference information.  Useful information such as specifications may also be found on the Ivex WW Web page.

��Each module should have the exact number of pins and identical pin names� XE "pin names" � that are used in the schematic.  For example, if you are using the TTL 7400 (14 pins) and you choose the module name 8DIP300 (8 pins), you will get errors when using this module in WinBoard because it does not have enough pins.  Likewise, if you name a pin on a transistor “Base” and the name of the pin on the module is “1” then you will have an error because the pin names do not match.

�symbol 70 \f "Wingdings" \s 30���NOTE: Refer to Application Note 08 for a more detailed description of assigning pin numbers.  This can be found on the Ivex WW Web page.

��

Reference Designator� XE "Reference Designator" � and Annotation� XE "Annotation" �

Each part has a “part reference� XE "part reference" �” and a “part value� XE "part value" �”.  When you place a part, such as a capacitor in the example below, the part reference is represented by C? and the part value is shown as CAP.  To edit this value, double click on the text “CAP” to get the Edit Field dialog box as shown in the example.  Type over the words CAP with a new value such as 47 pF and press the Change button.  Make sure the value you enter conforms to the requirements for the layout program.  Refer to the Appendix Things to Know for a list of WinDraft and WinBoard requirements.
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Figure 5-3: The Edit Field dialog box.



You do not need to edit the Part Reference manually because the Annotation tool does this for you.  To run Annotation, select Tools | Annotate and press the Execute button.

		�

Figure 5-4: The Annotate dialog box.



This will sequentially number all references that are similar.  For example all resistors that have the reference field R? will be sequentially numbered R1, R2, R3, etc.  If you have manually changed a reference, make sure you do not check the Unconditional box and it will keep the value you entered.

Reports� XE "Reports" �

There are two reports that you should run before generating your netlist, Bill of Materials (BOM) and Electrical Rules Check (ERC).



Bill of Materials (BOM)

To run BOM, select Utilities | BOM in the WinDraft menu.  In the Bill of Materials� XE "the Bill of Materials" � dialog box, select Module Name in the Fields Combine list, then press Execute.  This will generate a Bill of Materials with the module name.  This is useful because you can easily scan the list to see if there are any parts without a module name assigned. If there are any module names missing, you should go back to the sheet and add them to the parts.

If you do not know what name to assign to any particular part, choose a part from the available WinBoard libraries, or create your own using one of WinBoards’ module creation methods.

Electrical Rules Check� XE "Electrical Rules Check" � (ERC)

Run ERC to see if there are any reported violations.  If there are violations or warnings, then you should go back to the sheet and make the necessary corrections before you generate the netlist. 

Create Netlist

To create a netlist� XE "create netlist" �, select Utilities | Netlist Output.  This will open the Netlist Output� XE "Netlist Output" � dialog box as shown below:



	�

	   	Figure 5-5: The Netlist Output dialog box.

Select WinBoard in the Format entry box and Module Name in the Module entry box (these are both default settings).  You may enter an output name for the netlist in the Output File entry box, however if you do not, it will automatically generate a netlist with the name of your sheet followed by the .net extension and save it in your Project directory.



Press the Execute button to generate the netlist.  It will automatically run ERC and then generate a netlist report.  If there are ERC violations, it will stop the netlist process and you must return to the sheet to correct the violations. 

Other important information.

Refer to the Appendix “Things to Know� XE "Things to Know" �” for a list of Requirements in the netlist and other important areas.

If you are using a program that supports time stamps on the netlist other than WinDraft, or if you copy and paste parts in a schematic, always check the netlist to make sure that the Time Date Stamp is not duplicated.  The Time Date Stamp� XE "Time Date Stamp" � is a unique number assigned to each part as it is placed on the sheet.  Other programs may not generate this, or they may be duplicated if you copy and paste parts.  If these numbers are duplicated, you will have serious errors in the design when you go to PCB layout.







�Chapter 6:  WinBoard Tutorial

This tutorial takes you through the PC Board design process from a completed schematic to the final board file. You learn how to load the netlist, place the modules, route the tracks, place the board edge, edit silk screen, place and edit text, and place targets on the layout.

The Schematic

One of the best ways for you to quickly learn the features of WinBoard is to route a simple schematic. For this, we have created a schematic using the Orcad Schematic Capture Program. You may also use the WinDraft Schematics program, however we wanted to show how easy it is to import a schematic from another vendor.  Figure 3-5, shows the IVEX1.SCH schematic used in this tutorial. The IVEX1.SCH schematic is a circuit that is easily understood and can be routed within an hour. 



The circuit contains two transistors, two light emitting diodes (LED's) with radial leads, three axial lead resistors, one SPDT micro switch, and one axial lead capacitor. Power is supplied to the circuit through a 4 pin header. All components are through hole mounted.
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		Figure 6-1: The IVEX1.SCH schematic.

In the steady state, the base of transistor Q1 is grounded. Transistor Q1 is off, but diode D1 is actually turned on because it is receiving current through transistor Q2 which is turned on—the base of Q2 is pulled up to VCC through R2 and D1. Diode D2 is also turned on since Q2 is on. 

As the common lead of S1 is placed in the other position—connected to R1, Q1 turns on. Thus Q1 is in saturation. This pulls the collector of Q1 and the base of Q2 to GND. As a result, both transistor Q2 and diode D2 will be turned off. Diode D1 remains on, since Q1 is saturated. 

This circuit description is only given to assist you in understanding the techniques used in routing a simple board. As we progress through track routing and tracking the nets, it should be easier for you to follow what is actually going on by relating everything back to the schematic. 

Since the schematic was created with Orcad SDT, there are a few general guidelines to follow when you create your schematic. First, be sure to place the name of the WinBoard Module you intend to use, in the: 1st Part Field�XE "1st Part Field" \b� as you Edit parts or components in the schematic editor. 

For example:

Referring to S1 in Figure 3-5, notice that the module name: X201 is placed in the 1st Part Field on the schematic below the Part Value�XE "Part Value" \b� of SPDT. The module name is obtained from the WinBoard library of modules. If you do not know the name, you can leave the field empty as seen on JP1.

We have supplied you the Orcad schematic file for use with this tutorial. If you desire to print or generate your own netlist, find the IVEX1.SCH schematic file on the WinBoard disks and load this schematic file in the appropriate Orcad directory. 

The Netlist

After a schematic has been created and all of the required data is placed in the appropriate part fields, the next step is to create a netlist. This is done with your schematic editor. Ivex has supplied the WinBoard compatible netlist for the tutorial schematic. The netlist for IVEX1.SCH is called: IVEX1.NET, and is located on the WinBoard disks. The content of IVEX1.NET is also printed, in Figure 3-6. 

You may create your own netlists from an Orcad schematic file that is compatible with WinBoard. We have supplied a netlist conversion utility for creating WinBoard compatible netlists from Orcad schematics. The conversion utility converts Orcad schematics into the proper format to be read by WinBoard. 

If you plan to create your own netlist from an Orcad schematic, you may use the conversion utility called: fwinbrd.cf or fwinbrd.exe, depending on the version of Orcad software you are using. Both conversion files are located on the supplied WinBoard disks. 
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WinBoard

`I "ORCAD.IV.420";

`F "IVEX1.SCH";

`T "SAMPLE 1 - INVERTERS";

`S "May 11, 1994";

`C "IVEX1.SCH";

`R "1";

`C "IVEX DESIGN INTERNATIONAL";

`C "";

`C "";

`C "";

`C "";

`M RC05,,10K,F2EAFCB1,R1,C,GR1 

(1 VCC X 0.0)

(2 N00001 X 0.0);



`M CS13-A,,10UF,F49A5CB2,C1,C,GR1 

(1 VCC X 0.0)

(2 GND X 0.0);



`M TO-92,,2N4401-CBE,F64136EF,Q1,C,GR1 

(2 N00006 X 0.0)

(1 GND X 0.0)

(3 N00004 X 0.0);



`M TO-92,,2N4401-CBE,F64136F0,Q2,C,GR1 

(2 N00004 X 0.0)

(1 GND X 0.0)

(3 N00005 X 0.0);



`M RC05,,4.7K,F2EAFCAF,R2,C,GR1 

(1 VCC X 0.0)

(2 N00002 X 0.0);



`M RC05,,4.7K,F2EAFCB0,R3,C,GR1 

(1 VCC X 0.0)

(2 N00003 X 0.0);



`M ,,HEADER_4,F589BD0D,JP1,C,GR1 

(1 GND X 0.0)

(3 VCC X 0.0)

(4 ?2 X 0.0)

(2 ?1 X 0.0);



`M CK-05,,LED,F2EAFCAC,D1,C,GR1 

(1 N00002 X 0.0)

(2 N00004 X 0.0);



`M CK-05,,LED,F2EAFCAD,D2,C,GR1 

(1 N00003 X 0.0)

(2 N00005 X 0.0);



`M X201,,SPDT,F2EAFCAA,S1,C,GR1 

(1 GND X 0.0)

(2 N00006 X 0.0)

(3 N00001 X 0.0); 

			Figure 6-2 : Netlist for IVEX1.SCH.

Reading the netlist is fairly straight forward. The format is broken down into blocks which describe all of the connections that are made to each component. For example, in the first block:



	

`M RC05,,10K,F2EAFCB1,R1,C,GR1

(1 VCC X 0.0)

(2 N00001 X 0.0);��Figure 6-3: The first component definition in IVEX1.NET.

We see that the WinBoard module name: RC05, the part value: 10K, and the reference designator: R1, all appear in the first row. In addition, time stamp and other data also displays. The two nets that connect to resistor R1 appear in the next two rows. Pin 1of R1 is connected to VCC. Pin 2 of resistor R1 is connected to a net, labeled N00001. 

The schematic in Figure 3-5 illustrates all of the nets in this tutorial for easy reference and identification. Notice in Figure 3-5, that net N00001 is marked with a junction symbol. The junction symbol shows the net connecting R1 pin 2 to S1 pin 3. 

Starting the Tutorial

Now that you have read about the schematic and the netlist, you are ready to start the tutorial. The tutorial is divided into nineteen steps. We recommend that you work through the nineteen steps in numeric order. Otherwise, your board layout may turn out different than the layout used in this tutorial.

Step One: Loading the Netlist�XE "Netlist:Loading" \r "run_netlist" \b�

Loading the netlist into the program takes us through the process of assigning module names to parts on the schematics as well as assigning library names to already assigned module names.



WinBoard has an easy and very effective system for assigning modules. It may seem overwhelming at the first glance, especially with the size of the IVEX.NET netlist. However, as soon as you begin working on real designs you will discover the power of WinBoard. Ivex's basic philosophy is that you can load the netlist into WinBoard without assigning any of the module names. WinBoard gives you the option of finding the module and then assigning the module name.

In IVEX1.NET, some of the parts have module names assigned to them and some do not. Let's proceed.

Start WinBoard. Then follow these steps:

1.	Select the File from the pull-down menus.

2.	Then click on Load Netlist.

3.	Click OK. The Load New Netlist�XE "Load New Netlist" \b� dialog box displays.

	�

	   Figure 6-4: The Load New Netlist dialog box.

4.	Select ivex1.net and click OK. The Convert Net File�XE "Convert Net File" \b� dialog box displays. 

		�

    	         Figure 6-5: The Convert Net File dialog box.

Now the system tries to detect the net format. The program automatically detects that ivex1.net is an Orcad file and highlights it. 

1.	Be sure that the Orcad SDT IV  option (EDIF or WinBoard) is highlighted and click OK.

2.	Next the system converts the netlist, and displays the Netlist Module Selection�XE "Library Part Selection" \b� dialog box. Now the modules need to be assigned.
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			Figure 6-6:  The Netlist Module Selection dialog box.

3.	Look at the screen. You should see that all the modules in the last list box on the screen are marked with an asterisk in the leftmost column. This asterisk means that no module or library file name has been assigned. 

First we will let the system assign as much information automatically as possible:

1.	Click on Auto. Notice the automatic assign procedure assigning library names to the modules. The result is shown in figure 3-11. The asterisks are removed from the modules, and replaced by a + sign, which indicates that the Modules have been automatically assigned. 
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			Figure 6-7: The Netlist Module Selection dialog box.

2.	Looking at the dialog box we see that one module was not automatically assigned: JP1 HEADER_4. The reason JP1 HEADER_4 was not assigned is that it has no module name. So we have to find one. Now click on the JP1 HEADER_4  UNKNOWN line in the part list. It displays in the edit box above the list box.

3.	Click on Libraries. The Select Library Module dialog box displays. The Select Library Module dialog box is a box where you can look in the WinBoard module libraries. 

4.	Click on connectr.lib.

5.	Use the scroll bar to find the 4HDR-100 module and select it. The module displays in the black view field. 

6.	As this is the module we want to assign to JP1, click on the select button. The 4HDR-100 connectr.lib information is moved into the Edit field above the lower list box.

7.	To assign the module to JP1 press the Manual button. The information is moved into the Part list box. Now, no parts in the list are marked with an asterisk and you are ready to start loading the netlist.

8.	Click OK.

Now the system prompts for a stuff file name. This stuff file is used if you want to reload the netlist later and don't want to re-define all your modules. The stuff file keeps a list of the part values and the modules assigned to them. Loading this later, when you update the netlist, will enable you to automatically reassign the modules. With this size of netlist it will not save a significant amount of time. It can, however, be a very effective tool when loading larger ones.

Type ivex1.stf and click OK.

Now the system asks you if you would like to overwrite the netlist in the Save Converted Netlist dialog box.  To keep the module assignments you just made you can enter the name of a new netlist and press OK, or to continue without saving the new netlist press Cancel. 

Now the netlist loads the modules on the board and you are ready to start placing them.

Layout Philosophy

The layout philosophy described for this tutorial is typical of how you would proceed with any design. This tutorial shows you one way to proceed with the design. However, you may prefer a different approach that is optimum for your design. Let's get started.

Schematic File Name Used: �IVEX1.SCH—Created from Orcad��Netlist File Name Used:�IVEX1.NET—supplied by Ivex��Number of Components:�10—through hole mounted��Number of Board Layers:�2��

�SYMBOL 70 \f "Wingdings"��NOTE: Throughout this tutorial, we specify exact coordinates for many of the steps. In the examples to follow, coordinates are given in the text as: (1050, 850) for example. This actually refers to X=1050, Y=850 in WinBoard. If you are careful about placing the pointer on the coordinates mentioned, your tutorial PCB layout should match the final results as intended. Also, when we use the term "select" in the steps below, this generally refers to moving the pointer to a particular topic and clicking the left mouse button. ��

Step Two: Placing the First Module�XE "Placing Modules" \r "plac_mod" \b��XE "Modules:Placing" \r "plac_mod" \b�

Be sure that the WinBoard screen is maximized for optimum viewing. Notice that all of the modules (components) are placed in one area all together. In this section, we place the modules in preparation for routing. To begin, follow the steps outlined below:

�EMBED PBrush \s  \* mergeformat����1.	Move the pointer to the upper right portion of the screen and click on the Setup button as shown at left. ��2.	When the Setup dialog box displays, click on Object Selection.

3.	Under Texts section, disable the Part Value text by clicking the pointer on the Value Screen box—remove the x.

4.	Click OK, to return to the Setup dialog box.

5.	Click OK, to return to the work area.

The steps outlined above have turned off the silk screen Part Value� XE "disable text" � text associated with the modules. This is optional in your design. However, it does make layout easier to see by reducing the text clutter.  Notice that you can also deselect the module Part Reference and many other objects in this dialog box.

�EMBED PBrush \s  \* mergeformat����6.	Click on the Find, Get & Place Module button as shown at left. 

7.	The Find, Get & Place Module dialog box displays.��8.	Click on the C1 10uF capacitor.

9.	Type in the X coordinate 1000, and the Y coordinate 650 in the space provided.

10.	Type in the orientation 90 degree in the box next to orient to rotate the module.

11.	Press the Place button to move the module to the new location.

Step Three: Updating Your  Work�XE "saving your  work" \b� to a File

At this point, you may wish to take a quick break. To update or save your work to a file, follow the steps outlined below:

�EMBED PBrush \s  \* mergeformat����1.	Click on either the Save button in the toolbar, as shown at left, or the File pull-down menu.��2.	Enter the name of the file that you wish to update or save your work to and select OK. We recommend that all board files be saved with a .BRD file extension.

Step Four: Placing the Remaining Modules

The remaining modules may be placed in the same manner as the C1 capacitor is Step Two.  However we have included a Placement File and you may place all the remaining modules at once using this unique WinBoard feature. 

1.	Select Utilities and then Place File from the WinBoard menu.

2.	In the Load Placement File dialog box, select ivex1.plc.

3.	Press the OK button, this will automatically place the remaining modules.

Step Five: Refresh the Screen�XE "Refreshing the Screen" \b�

��Click on the Refresh Screen button as shown at left, or just press z to refresh and center the screen at the location of the pointer. ��Step Six: Compare Your Work

Now that you have completed placing all of the modules, compare the work you have done with Figure 3-10. If you placed the modules at the coordinates specified, your work should look very similar. If your modules are in slightly different locations, the following routing section will NOT align with the locations of your modules. However, go ahead and continue with the tutorial. It will still be easy to get the general concepts of routing with WinBoard. If you like, take a break and save your work. The next step explains routing.

�

	Figure 6-8: Placement of all Modules

Step Seven: A Little “Tweak” 

�EMBED PBrush \s  \* mergeformat��EMBED HJPRO \s  \* mergeformat�����1.	Click on the Compute Netlist button as shown at left

2.	The Nets & Netlist dialog box displays.��3.	Click on Show in the upper right corner of the dialog box.

4.	Press z to refresh the screen.

5.	The ratsnest displays on the screen as yellow connection points. With the Show selection made in step three above, you highlighted all of the nets in this design. Refer to Figure 3�13. 

6.	The first time you see the ratsnest, you may not notice subtle module placement errors that were made when you placed the modules. With experience, you will notice ways to better place the modules to enhance your routing. However, a resistor in this tutorial should be rotated 180�SYMBOL 176 \f "Symbol"� from their current placement. As you will see, this will make the resistor pins that are connected to VCC easier to route.

Reorient the R3 resistor:

1.	Move the pointer to coordinates (2150, 600) at the bottom of resistor R3 and click the left mouse button once. The hand pointer displays, signifying the object placement mode.

2.	Press the left arrow key twice to rotate the module.

3.	Hold down the left mouse button on pin one and drag the module to coordinates (2150, 200).

4.	Release the left mouse button. The module has been re-oriented. Refer to Figure 3-14 for the illustration of the modified ratsnest layout.

	�

	      Figure 6-9: Initial ratsnest layout

	�

	  Figure 6-10:  Modified ratsnest layout

Step Eight: The First Route

Before you begin, you will be routing on layer one. Press c to change to the solder layer. The default color of the solder layer is red. You placed the modules on layer two, the component layer. The component layer is always the highest numbered layer of the PC board. Since this is a two layer board, the component layer is layer two.

1.	With the ratsnest shown on the screen, and the arrow pointer at coordinates (2150, 200)—the upper end of resistor R3, proceed to route the VCC net.

2.	Press r to enter the routing mode. The pointer arrow changes slightly, with a T displayed next to it.

3.	Click the left mouse button once on the R3 pad located at (2150, 100).  You may also press b to begin routing rather than using the left mouse button.

5.	Move the pointer to R2 pin one at coordinates (1850, 200).

6.	Click the left mouse button when you are on  the pad (or press b again, for begin).

7.	Move the pointer to coordinates (1450,200) and press b again.

8.	Continue to move the pointer toward the Header module, stopping at coordinates (1050, 400).

9.	Press b.

10.	Move the pointer to the top pin of C1, stopping at coordinates (1000, 700).

11.	Press n, to end the route. The VCC net is completely routed.

�EMBED PBrush \s  \* mergeformat���	��EMBED PBrush \s  \* mergeformat���

�EMBED PBrush \s  \* mergeformat���

�EMBED PBrush \s  \* mergeformat����As you routed the track in the previous steps, you may have noticed that the track segment being routed was white. The track segment was also paralleled by a red colored band. This red band, is the guard band or isolation. The track isolation can be specified by clicking the Track, Outline & Edge button, as shown at left, and changing the track isolation setting in the dialog box. ��In addition, while you are routing, you can easily change the track width by pressing w after you have pressed b. Pressing s while routing mirrors the track—this is very useful for correct pad entry.

Step Nine: Routing the Ground Tracks

1.	To begin routing the GND tracks, move the pointer toward the Header module and stop at coordinates (950, 400)—the square pad.

2.	If WinBoard is not in routing mode, press r to display the routing mode pointer. Next, press b to begin routing.

3.	Move the pointer to coordinates (850, 450) and press b.

4.	Move the pointer to coordinates (900, 1300) and press b.

5.	Move the pointer to coordinates (1000, 1400) at the lower pad of capacitor C1. If necessary, press s for proper pad entry.

6.	Press b.

7.	Move the pointer to coordinates (1150, 1350) and press b.

8.	Move the pointer to coordinates (1200, 1250) and press b.

9.	Move the pointer to coordinates (1350, 1250) at the lower pad of the switch S1 and press b.

�SYMBOL 70 \f "Wingdings"��NOTE: While routing it is often helpful to press the home key to zoom in, and the end key to zoom out.��Continue routing:

1.	Move the pointer to coordinates (1550, 1350) and press b.

2.	Move the pointer to coordinates (1850, 1350) at the lower pad of transistor Q1 and press b.

3.	Move the pointer to coordinates (2150, 1350) at the lower pad of transistor Q2 and press n to end the route.

Step Ten: Routing Resistor R3 and Diode D2 Tracks

1.	Move the pointer to coordinates (2150, 600) at the lower end of resistor R3.

2.	If WinBoard is not in routing mode, press r to display the routing mode pointer. 

3.	Press b to begin routing.

4.	Move the pointer to coordinates (2150, 850) and press n to end the track.

5.	Move the pointer to coordinates (2150, 1050) at the lower end of diode D2 and press b.

6.	Move the pointer to coordinates (2150, 1300) at the collector pad of transistor Q2 and press n to end the track.

Step Eleven: Routing Resistor R2 and Diode D1 Tracks

1.	Move the pointer to coordinates (1850, 600) at the lower end of resistor R2.

2.	If WinBoard is not in routing mode, press r to display the routing mode pointer. Next, press b to begin routing.

3.	Move the pointer to coordinates (1850, 850) and press n to end the track.

4.	Move the pointer to coordinates (1850, 1050) at the lower end of diode D1 and press b.

5.	Move the pointer to coordinates (1850, 1300) at the collector pad of transistor Q1 and press n to end this route.

Step Twelve: Routing the Q1's Collector to Q2's Base

1.	Move the pointer to coordinates (1850, 1250) and press b.

2.	Move the pointer to coordinates (2000, 1300) and press b.

3.	Move the pointer to coordinates (2150, 1300) at the base pad of transistor Q2 and press n to end the route.

Step Thirteen: Routing the Switch Common Lead to Q1's Base—Net N00006

1.	Move the pointer to coordinates (1350, 900) and press b.

�EMBED PBrush \s  \* mergeformat����2.	Let's try a different track angle for this route. Press x to toggle to the arc mode, as shown at left.��3.	Move the pointer to coordinates (1500,1200) and press b. If necessary, press s to mirror the route so that it goes under the pad.

4.	Move the pointer to coordinates (1650,1250) and press b.

5.	Move the pointer to coordinates (1850, 1300)—on the middle pad.

6.	Press s to enter the pad at the correct angle then n to end. 

Step Fourteen: The Final Route—Net N00001

1.	Move the pointer to coordinates (1450, 600) at the lower pad of resistor R1 and press b.

2.	Still in the arc routing mode, move the pointer to coordinates (1500,1050).

3.	Press n to end the route. 

The routes should resemble those shown in Figure 3-15 below.

�

		Figure 6-11: Routed nets.

Step Fifteen: Placing the Board Edge�XE "Placing Board Edges" \b��XE "Board Edge:Placing" \b�

�EMBED PBrush \s  \* mergeformat���	�	�1.	Click on the Track Outline & Edge button as shown at left. The Track, Outline & Edge dialog box displays.

2	In the Type section, click on Board Edge to enable it—a black dot should display.��3.	In the Style section, click on 90 deg.

4.	Click OK to return to the work area. WinBoard should be in routing mode with the route pointer displaying.

5.	Move the pointer to coordinates (550, 150) and click the left mouse button or press b.

6.	Move the pointer to coordinates (2300, 150) and press b.

7.	Move the pointer to coordinates (2300, 1450) and press b.

8.	Move the pointer to coordinates (550, 1450) and press b.

9.	Move the pointer back to the original starting location at coordinates (550, 150) and press n to end. Refer to figure 3-16.

�

	   Figure 6-12: Board routes and edge with text

Step Sixteen: Silk Screen Editing�XE "Silk Screen Editing" \b��XE "Editing Silk Screen" \b� (optional)

1.	Click on the Setup button. The Setup dialog box displays.

2.	Click on the Object Selection button. The Object Selection dialog box displays.

3.	In the Texts section, click in the Silk Screen check box to enable silk screen. An x should display in the check box.

4.	Click OK to return to the Setup dialog box.

5.	Click OK to return to the work area. The silk screen text is now visible on the screen.

�6.	Move the pointer to the Grid list box on the toolbar and select it by clicking on the arrow. 	���7.	Change the grid spacing from 50 mils to 5 mils.



Move the JP1 text:

1.	Move the pointer to the text JP1 at coordinates (825, 245).

2.	Make sure you are on the Component layer.  Hold down the Ctrl key and click the left mouse button. The pointer should change to the hand. 

3.	Press and hold the left mouse button down again to move the text.

4.	Move the text to coordinates (950, 210) and release the mouse button.

Move the 10 uF text:

1.	Move the pointer to coordinates (845, 940) to drag the 10 uF capacitor text.

2.	Hold down the Ctrl key and click the left mouse button. The pointer should change to the hand. 

3.	Hold down the left mouse button again to drag the text.

4.	Move the text to approximately coordinates (1110, 1060) and release the mouse button.

Move the S1 text:

1.	Move the pointer to coordinates (1225, 1245) to move the S1 switch text.

2.	Hold down the Ctrl key and click the left mouse button. The pointer should change to the hand. 

3.	Press and hold the left mouse button again to move the text.

4.	First, let's rotate the text before placement. Press the right arrow key once. 

5.	Move the text to approximately coordinates (1350,725) and release the mouse button.

Now, let's move the SPDT text to clean up that area:

1.	Move the pointer to near coordinates (1600, 1250). 

2.	Press and hold down the Ctrl key while pressing and releasing the left mouse button. The text changes from yellow to white.

3.	Hold down the left mouse button and move the pointer to coordinates (1610, 980).Release the mouse button. 

4.	If necessary, press Home to zoom in.

Edit the transistor text:

1.	Move the pointer to near coordinates (1905, 1135). 

2.	Hold down the Ctrl key while pressing and releasing the left mouse button. The text changes from yellow to white.

3.	Press the left arrow key twice to rotate the text.

4.	Hold down the left mouse button and move the text near coordinates (1820, 1075).

5.	Now, move the pointer near coordinates (2000, 1140). 

6.	Hold down the Ctrl key while pressing and releasing the left mouse button. The text changes from yellow to white.

7.	Press the left arrow key twice to rotate the text.

8.	Move the pointer over the text, hold down the left mouse button and move the text near coordinates (2090, 1140). Be sure to place the entire text within the board edge.

Move the Q1 text:

1.	Move the pointer to coordinates (1940, 1465) to move the Q1 transistor reference designator text.

2.	Hold down the Ctrl key while pressing and releasing the left mouse button. The text changes from yellow to white.

3.	The pointer should change to the hand. Press the left arrow key twice to rotate the text. 

4.	Move the text to approximately coordinates (1710, 1400) and release the mouse button.

Move the Q2 text:

1.	Move the pointer to coordinates (2250, 1475) to move the Q2 transistor reference designator text.

2.	Hold down the Ctrl key while pressing and releasing the left mouse button. The text changes from yellow to white.

3.	The pointer should change to the hand. Press the left arrow key twice to rotate the text. 

4.	Move the text to approximately coordinates (2040, 1400) and release the mouse button.

5.	Refresh the screen by pressing z.

Step Seventeen: Placing Silk Screen Text�XE "Placing Silk Screen Text" \b��XE "Silk Screen Text:Placing" \b�

�EMBED PBrush \s  \* mergeformat� ���1.	Click on the Text button as shown at left.��2.	Click in the text entry box with the left mouse button.

3.	Enter the text: Inverters in the text field.

4.	Change the text thickness to 10 by clicking on the arrows to the right of the Thickness entry box with the left mouse button.

5.	Change the text height to 65 by clicking on the arrows to the right of the Height entry box with the left mouse button.

6.	Change the text width to 50 by clicking on the arrows to the right of the Width entry box with the left mouse button.

7.	Change the text orientation to 9000 by clicking on the arrows to the right of the Orientation entry box with the left mouse button. Now click in the check box to the left of Mirror / x and Mirror / y to place an x in each check box.

8.	In the Type section, click in the circle to the left of Silk and click OK to accept the changes and return to the work area. The Inverters text should now display on screen.

9.	Move the pointer to place the text at approximately (685, 990) by pressing and releasing the mouse button. Then press Esc or the right mouse button.

Step Eighteen: Final Text Editing�XE "Text Editing" \b��XE "Editing Text" \b� 

1.	Move the pointer back to the transistor text located near (2090, 1140).

2.	Hold down the Ctrl key and double click the left mouse button. The Text dialog box displays.

3.	Change the Width to 20, Height to 30, Spacing to 25, and click OK.

4.	Hold down the Ctrl key and click on the text again.

5.	Hold down the left mouse button and move the text to center over the transistor.

6.	Move the pointer to the transistor text located near (1820, 1075).

7.	Hold down the Ctrl key and double click the left mouse button. The Text dialog box displays.

8.	Change the Width to 20, Height to 30, Spacing to 25, and click OK.

9.	Hold down the Ctrl key and click on the text again.

10.	Hold down the left mouse button and move the text to center over the transistor.

Step Nineteen: The Last Step

�EMBED PBrush \s  \* mergeformat��EMBED PBrush \s  \* mergeformat� ����1.	Click on the Target button as shown at left.

2.	In the Style section, click in the circle next to T4.��3.	Change the External Dimension to 200.

4.	Click OK, then press the z key to refresh the screen if necessary.

5.	The outline of the Target is now on the end of the pointer.

6.	Move the pointer to coordinates (500, 1500) and click the left mouse button.

7.	Move the pointer to coordinates (2400, 100) and click the left mouse button.

8.	Press Esc or the right mouse button and you are done.

Congratulations, you have completed the board.

	�

			Figure 6-13: The final board

�Appendix:  Things to Know

WinDraft Table of Requirements

WinDraft Schematic Item�Requirement to know:�����Net Names�Maximum length is 128 characters.

See WinBoard valid name delimiters.��Net Names to Specctra�Must not include “\”, “X”��Pin numbers�These are usually numbers, not names. 

They  must match the name/number used for the pad in the PCB module footprint.��Library parts�The part must have a starting reference letter such as “R” for R?.��Module Name: �Use WinBoard or Ivex PCB module footprint name.��Part REF (reference)�Maximum length 8 characters. 

First character is usually a letter (not numeric).��Part VAL (value)�Maximum length 14 characters.

Do not use parenthesis “(“ or “)”  see WinBoard

valid name delimiters.��

�WinBoard Table of Requirements

WinBoard PCB Item�Requirement to know:�����Part REF (reference)�Maximum length 8 characters. ��Part VAL (value)�Maximum length 14 characters.��Module Requirements�Must have at least one pad.

The text “Part REF” and “Part VAL”.

A Grip point.

A Reference Bookmark.��Module Name�Maximum length 14 characters.��Valid name delimiters�Use an underbar or dash. Do not use quotations “” spaces, parenthesis ( ) or commas.��Pad Stack�Maximum length 7 characters.��Pad numbers�These are usually numbers, not names. 

They must match the name/number used for the pin in the schematic part.

Maximum length 4 characters.��Library file name�Must follow “DOS” file name conventions:  may not contain spaces or be more than 8 characters.��Grip Point�This is usually on pin one for through-hole devices and at the center of an SMD device.��Reference Book Mark�This is usually on pin one, the point around which the part rotates.��Net names�Maximum 128 characters, see Valid Delimiters.��Board layers�Minimum is 1, maximum is 16.��Board Edge�This should be drawn as one continuous line for CCT Specctra autorouter.��Zone or copper area�Do not edit an arc outline of a zone.��
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Figure 5-1: The Edit Part dialog box.
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